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Foreword 
New Jersey is truly a coastal state, encompassing 127 

miles of Atlantic coastline and nearly 1,800 miles of 

estuarine shoreline.  The coastal zone is comprised of 

multiple shoreline types, including spits, headlands, 

high-energy barrier island systems, mixed-energy barrier 

island systems, and bays, all of which sustain habitat and 

wildlife, support viable maritime and tourism industries, 

and harbor a way of life for many New Jersey residents. 

Approximately 1.8 million people live within the coastal 

counties of New Jersey.
1
  These numbers drastically 

increase during the summer months as visitors travel 

from a wide region to enjoy the pleasures of the State’s 

recreational resources and vacation destinations, 

supporting a $16 billion annual tourism industry.
2
  The 

same resources and scenic views that support recreation 

and tourism provide a nursery for the State’s $2.1 billion 

commercial fishing industry
3
 and a $50 billion maritime 

industry.
4
 While the coastal zone is a financial engine for 

the State, it also provides critical habitat for endangered 

and threatened species, serves as a host for migratory 

birds, and sustains ecosystem services such as flood 

control and stormwater filtration.   Unfortunately, much 

of New Jersey’s coastal landscape is threatened by the 

impacts of episodic and chronic erosion, subsidence, 

shallow coastal flooding, nor’easters, tropical storms and 

hurricanes.  

 

Historically, coastal communities have merely responded 

to the impacts of natural hazards.  In recent decades, the 

federal government has proactively attempted to protect 

people and property from natural disasters by improving 

coastal construction standards, developing incentives to 

reduce flood losses, and requiring mitigation planning in 

order for local governments to obtain pre- and post-

disaster mitigation funding.  New Jersey has further 

strengthened floodplain construction standards by 

requiring all new development to be constructed two feet 

above base flood elevation.  Despite federal and state 

efforts, coastal development continues to be sited in high 

hazard areas, increasing property damage losses and 

                                                 
1
 US Census Bureau. (2010). 

2
 NJDEP: CMP. (2002). 

3
 NOAA. (2006). 

4
 NJDEP: CMP. (2002). 
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“People typically are unaware of 

the hazards they face, 

underestimate those of which they 

are aware, overestimate their 

ability to cope when disaster 

strikes, often blame others for 

their losses, underutilize pre-

impact hazard strategies, and rely 

heavily on emergency relief when 

the need arises.”   

 

--Dennis S. Mileti,  

   Disasters by Design, 1999 
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recovery costs for coastal communities.  Since 1960, New Jersey coastal counties have 

experienced over $970 million in property damage and crop loss as a result of coastal storms and 

flooding.
5
  Climate change threatens to exacerbate the impacts of coastal hazards by increasing 

the frequency and intensity of coastal storms, accelerating rates of sea level rise, increasing 

coastal erosion, and inundating low-lying portions of the shore.
6
  As a result, more people, 

development, and natural resources will be vulnerable to the impacts of coastal hazards than in 

the past.  While communities will have ample time to plan for increases in sea level, they will be 

challenged by stronger and more frequent coastal storms.  Projections indicate that Atlantic City 

will likely be impacted by 100-year storms every 5 to 30 years,
7
 and similar increases in storm 

patterns will likely occur in coastal regions throughout the state.  Local decision-makers continue 

to have the greatest influence on their community’s resiliency through land use planning and 

permitting, floodplain management, disaster preparedness, and public education. Unfortunately, 

few communities are aware of their existing vulnerabilities to coastal hazards, let alone, the 

potential impacts of climate change and sea level rise.     

 

The ability of coastal communities to remain resilient to coastal hazards is rooted in 

understanding their potential exposure and vulnerabilities. However, there is currently a lack of 

clear guidance to assess existing and future hazard vulnerabilities on the local level.  Existing all-

hazard mitigation plans are typically developed on the county level and do not provide 

vulnerability assessments of cultural and historic properties, businesses, critical natural 

resources, or other features that are integral to a community’s character, nor do they typically 

address the potential impacts of climate change.  Without baseline information, it is difficult for 

communities to identify and implement hazard mitigation and climate adaptation strategies.   

 

In September 2006, a “Summit Confronting Climate Change in New Jersey” was convened to 

examine the economic ramifications of global climate change, sea level rise, and coastal hazard 

impacts for the State of New Jersey and generate strategic policy options that the State should 

consider.  One of the recommendations stemming from the Summit was the need to develop 

more accurate information to determine the degrees of vulnerability to coastal hazards in New 

Jersey’s coastal communities. Recognizing that coastal decision-makers need access to 

resources, tools and science-based information, the New Jersey Coastal Management Program 

identified coastal hazards as a top priority area in its 2006-2011 Section 309 Strategy.  Through 

the support of federal, state, and local partners, the New Jersey Office of Coastal Management 

developed the Coastal Community Vulnerability Assessment and Mapping Protocol and the 

Getting to Resilience questionnaire to help coastal decision-makers understand and address the 

full spectrum of factors that influence community resilience.  These tools can be used to inform 

and improve state and local policies and regulations, spur interagency collaboration and educate 

the public on natural hazards in their community.  By providing coastal communities with the 

criteria they need to assess their vulnerability and resilience to coastal hazards (ie. storm surge 

and sea level rise), they will have the necessary knowledge to guide their land use, hazard 

mitigation, emergency management, and conservation efforts in a more holistic and sustainable 

manner that considers both present and future conditions of the shore. 

                                                 
5
 Hazards & Vulnerability Research Institute. (2011). Adjusted to 2011 dollars. 

6
 U.S. Indian Ocean Tsunami Warning System Program. (2007). 

7
 Cooper, M.J.P.; Beevers, M.D.; and M. Oppenheimer. (2005). 
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How to Use this Document  
 

This document is intended as a guide for entities interested in assessing their vulnerability to 

coastal hazards. Coastal vulnerability is a complex topic that requires an understanding of some 

basic terms, concepts, and historical context to be effectively assessed. This document will 

navigate through these steps in the following way: 

 

 

 

 

 

 

 

  

Explanation of basic definitions and relevant concepts on hazards that 

face our coastal areas 

Explanation of the Assessment Tools developed by the New 

Jersey Office of Coastal Management 

The Coastal Community Vulnerability and Mapping Protocol is 

presented in a ‘Cookbook’ format that will introduce publically 

available data and walk the user through the steps to create a Coastal 

Vulnerability Index (CVI) for their area of interest. Vulnerability can 

be assessed by overlaying built environment, natural environment, and 

social vulnerability data over the CVI  
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Definitions  
 

Risk is the probability of harmful consequences or expected losses (death and injury, 

losses of property and livelihood, economic disruption, or environmental damage) 

resulting from interactions between natural or human-induced hazards and vulnerable 

conditions.
8
 Risk from coastal hazards is characterized by the frequency of occurrence and 

severity of a hazard.
9
 

 
Vulnerability is the degree of exposure and 

inability of a human or natural system to cope with 

the effects of a natural hazard, including changing 

variability and extremes in weather and climate. 
 
Resilience is the capacity of a system, community, 

or society potentially exposed to hazards to adapt, 

by resisting or changing, in order to reach and 

maintain an acceptable level of functioning and 

structure.
10

 
 
Resilience has an inverse relationship with risk and 

vulnerability.  In a resilient system, change has the potential to create opportunity for 

development, novelty, and innovation.  While in a vulnerable system, even small changes 

may be devastating.  To build coastal community resilience to both chronic and episodic 

coastal hazards, linkages between community development, coastal management, and 

disaster management activities are needed. These linkages need to be explicit and driven by 

community members themselves, working in concert with national and local government 

programs and NGOs. Community-based planning and assessment of coastal hazards and 

risks is a fundamental first step in building coastal community resilience. Coastal 

communities can then take deliberate actions to avoid disaster through improved planning, 

mitigation, and recovery procedures. Such mitigation and adaptation measures are critical to 

build resilience and should continuously be updated and improved upon by lessons learned 

from past hazard events and projections of future hazard scenarios.
11

   
 
Hazard Mitigation is sustained action taken to reduce or eliminate the long-term risk to 

human life and property from natural hazards and their effects. Mitigation focuses on 

breaking the cycle of disaster damage, reconstruction, and repeated damage, creating safer 

communities, and reducing loss of life and property.
 12

 
 
Climate Adaptation is the adjustment of natural or human systems in response to actual 

or expected climatic stimuli or their effects, which moderates harm or exploits beneficial 

opportunities.
13

 

                                                 
8
 Subcommittee on Disaster Reduction. (2005). 

9
 US Indian Ocean Tsunami Warning System Program. (2007). 

10
 Subcommittee on Disaster Reduction. (2005). 

11
 US Indian Ocean Tsunami Warning System. (2007). p 3-8 

12
 FEMA. http://www.fema.gov/about/divisions/mitigation.shtm  

13
 IPPC. (2007). 

http://www.fema.gov/about/divisions/mitigation.shtm
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Coastal Hazards 

New Jersey coastal communities are susceptible to numerous types of coastal hazards, including 

erosion, coastal storms, and flooding. Despite this susceptibility, people and businesses continue 

to locate along the shore.  Often times, they are unaware of the potential hazards that they face 

both structurally and financially. Because coastal communities are highly vulnerable to coastal 

processes and hazards, coastal decision-makers should understand the risks and deter future 

development and redevelopment away from high hazard areas.  

Erosion is one of the most common and 

persistent hazards along the Jersey shore.  

Wind, currents, and waves are the main 

contributors to erosion.  While most 

communities have identified mitigation options 

to reduce the rate of erosion, some portions of 

the shore have been lost due to persistent 

erosion that was not amicable to shore 

protection methods.  Coastal erosion is 

typically exacerbated by episodic storm 

events, including tropical storms, hurricanes, 

and nor’easters. Tropical events typically occur 

between the months of May and November, 

while nor’easters occur during the winter months.  Coastal storms are commonly associated with 

high levels of rainfall, high winds, high seas, and are known to produce powerful storm surges 

that result in flooding and property loss.  Unlike tropical storms and hurricanes, which are 

typically fast moving storms, nor’easters generally move slowly, tend to stall and cause coastal 

and riverine flooding over a longer duration than 

a fast moving tropical storm. Tides and winds 

can heighten the impacts of coastal storms. 

Barnegat Bay and other semi-enclosed bays are 

prone to back-bay flooding during storm events 

because high winds and narrow inlets trap 

upland rainfall and tidal waters in the bay.  Such 

flooding can overwash barrier islands and spits 

from both the back bay and ocean, creating new 

inlets and damaging properties. Normal, episodic 

spring tides can also cause shallow coastal 

flooding. Because the Jersey shore is highly 

developed, coastal flooding not only threatens 

lives and private property, it threatens roads and 

bridges, stormwater infrastructure, utilities, and 

businesses. Understanding inundation patterns in 

one’s community can inform the location or 

relocation of critical infrastructure, inform 

evacuation procedures, and guide post-disaster 

redevelopment.   

  Map 2: Historic Shorelines Near Cape May Point 

Map 1: Historic Storm Tracks, 1850-2008 
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Global climate change is expected to increase the rate of sea level rise resulting in increased 

saltwater intrusion into coastal aquifers, increase levels of land-based pollutants into coastal 

waters, and more powerful El Nino and La Nina events.
14

 As a result, more people, property, 

infrastructure, habitat and wildlife will be exposed to coastal hazards than in the past. Due to 

local geologic factors, including subsidence, depleted sedimentation, and glacial isostatic 

adjustment, New Jersey already experiences higher than average rates of sea level rise in 

comparison to global averages.  Long-term tide gauge data indicates that the New Jersey coastal 

zone has experienced sea level 

rise rates of 3.90 to 4.05 mm/year 

since the beginning of the 

twentieth century.
15

  If this trend 

were extrapolated into the future 

without considering accelerated 

rates of sea level rise due to 

global climate change, the New 

Jersey shore could experience 

approximately 0.4 meters (1.3 

feet) of sea level rise over the 

next century, nearly twice global 

averages. But projections indicate 

that the seas will vertically rise 0.5 to 1.5 meters (~1.6 to 4.9 feet) by 2100 as a result of 

increased global temperatures, thermal expansion of water, glacial and Arctic ice sheet melting, 

and localized conditions.
16

  Researchers from Rutgers University and the New Jersey Geological 

Survey agree that sea level rise along the East Coast will exceed 1 meter (~3 feet) by 2100.
17

  As 

climate change alters the natural processes of the New Jersey shore, coastal communities will 

likely experience more regular shallow coastal flooding events, greater rates of salinity intrusion 

into freshwater resources, changes in and loss of critical habitat, and more intense and frequent 

coastal storms. Additionally, the life expectancy of coastal engineering projects will decrease, 

the cost of shoreline stabilization will increase, making coastal resource protection harder to 

achieve.
18

 

 

Because climate change is expected to accelerate overtime, little change will be visible on a year 

to year basis, making it difficult to make the case to plan for changing coastal conditions. 

However, as time goes on, the cumulative increase in sea level will become evident. Multiple 

studies have been undertaken to identify the threat of accelerated sea level rise and exacerbated 

coastal storms to the Jersey shore.
19

  These studies have been effective in providing insight on 

potential changes in flooding and habitat, but comprehensive hazard and vulnerability 

assessments have not been performed on the county or municipal scale. The assessment tools 

identified in this document are intended to provide guidance on how to perform local 

assessments and take steps to improve resilience to existing and future hazard conditions.    

                                                 
14

 US Indian Ocean Tsunami Warning System Program. (2007). 
15

 NOAA. (2011).  
16

 PDE. (2010); Najjar, R., Patterson, L., and S. Graham. (2009); Ramstorf, S. (2007).  
17

 Miller, K., Sugarman, P.J., and J.V. Browning. (2011).  
18

 Hayes, M. (2004). 
19

 PDE. (2010); Lathrop, R. G. and A. Love. (2007); Cooper, M. J.P., Beevers, M. D., and M. Oppenheimer. (2005).  

Figure 1: Atlantic City’s Sea Level Rise Trend 

Source: NOAA. 2011. Sea Level Rise Trends  
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Vulnerability and Resilience Assessment Tools 
 

To help assess their vulnerability and resilience to coastal hazards, coastal decision-makers need 

access to resources, tools and science-based information. The New Jersey Office of Coastal 

Management (NJOCM) incorporated elements from numerous tools, guidebooks, and training 

courses to develop two assessment tools to ensure that coastal communities have consistent and 

comprehensive guidance to assess their vulnerability and capacity for resilience. The Coastal 

Community Vulnerability Assessment and Mapping  Protocol (CCVAMP) was developed to 

guide communities through the development of a geospatial vulnerability assessment, while the 

Getting to Resilience
20

(GTR) questionnaire was assembled to assist local decision-makers review 

and characterize their existing planning, response and recovery efforts to identify opportunities 

to support community resilience.  These tools provide a consistent means to identify and assess 

the potential impacts of coastal storms and sea level rise throughout coastal regions of the state; 

which can then inform local and regional planning, hazard mitigation, and emergency 

management efforts.   

The NJOCM strategically approached the development of vulnerability and resilience assessment 

tools so they are not only useful for identifying potential exposure to flooding and storm threats, 

but could identify ways to incorporate hazard mitigation and climate adaptation measures into 

existing programs and plans, such as local ordinances, master plans, evacuation procedures, and 

all-hazard mitigation plans.   In order to do so, the NJOCM suggests that the CCVAMP and the 

GTR questionnaire be used together to ensure that local decision-makers discover the full 

spectrum of factors that contribute to their community’s resilience. Because coastal communities 

vary in size and capacity, communities may approach the execution of the vulnerability and 

resilience assessments in different manners.  Some communities may have the staff and the 

technical capabilities to generate a vulnerability assessment, while others may choose to contract 

a consultant.  While the capabilities of the communities may vary, the NJOCM recommends that 

the assessments involve the participation of representatives from local government sectors, 

special interest groups (i.e. business sector and conservation organizations) and the public.  By 

involving a broad group of people in the assessment process, the community will build support 

around the team’s findings and recommendations.  Coastal communities should seek partnerships 

to obtain technical or facilitation assistance.  Results of the assessments can be incorporated into 

all-hazard mitigation plans or climate adaptation plans and may help communities earn 

Sustainable Jersey™ points and identify ways to improve their Community Rating System scores.   

   

The methodology outlined in this report is intended to allow its users to identify their existing 

and future hazard exposure, in addition to the types of factors that a community should consider 

when embarking on a vulnerability assessment. While the Coastal Community Vulnerability 

Assessment and Mapping Protocol and the Getting to Resilience questionnaire are intended to be 

used together, the vulnerability mapping methodology can be used to assess vulnerability at 

varying scales, such as the county, watershed, or regional scale.  The mapping methodology was 

first piloted on a regional level along the Delaware Bay to ensure its scalability.  The NJOCM 

then piloted the vulnerability assessment tool and GTR in communities along the Jersey shore. 

                                                 
20

 NJDEP. NJOCM. (2011a). 
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Coastal Community Vulnerability Assessment and Mapping Protocol  
 

Community resilience is highly dependent upon the location of development in relation to high 

hazard areas.  In order for local governments to take proactive measures to adapt, mitigate, and 

plan for episodic events or long-term changes in the shoreline, they must first be aware of the 

hazards they face and the potential exposure of 

people, property, and resources.  As maps are 

one of the best means to convey information to 

decision makers, the NJOCM developed the 

Coastal Community Vulnerability Assessment 

and Mapping Protocol (CCVAMP) to assist 

land use planners, hazard mitigation planners, 

emergency managers, and other local decision-

makers in the identification of their 

community’s vulnerability to coastal hazards. 

The CCVAMP defines the necessary steps to 

geospatially identify vulnerable land areas 

under present and future inundation scenarios, 

whether it be shallow coastal flooding due to 

spring tides, storm surge, or sea level rise.  

Through the development of inundation scenarios, coastal decision-makers can then determine 

threats to built infrastructure, sensitive natural resources, and special needs populations. The first 

step in the analysis is the development of a Coastal Vulnerability Index (CVI), which stratifies 

high hazard areas in coastal communities by compiling available hazard, elevation, and 

landscape geospatial data into an environmental constraint model. Armed with the understanding 

of areas naturally predisposed to risk, coastal decision-makers may guide future development 

away from high hazard areas and mitigate future losses. The vulnerability assessment 

methodology is based on numerous risk and vulnerability assessment methodologies,
21

 including, 

but not limited to, NOAA Coastal Services Center’s Roadmap to Adapting to Coastal Risk and 

Inundation Mapping Guidebook.  

 

Prior to pursuing the development of inundation and vulnerability maps, community leaders 

should work with a group of engaged decision-makers, special interest groups, and the public to 

define an acceptable level of risk to various hazard scenarios.  While it is suggested that a 

community develop multiple inundation scenarios to understand the full breadth of their 

vulnerability, some communities may choose to only assess past hazard scenarios.  Other 

communities may choose to comprehensively assess past storm and future inundation scenarios 

and local vulnerabilities. After completing a risk and vulnerability assessment, it is 

recommended that community leaders share the available information as a means to inform 

community planning, mitigation, response, and recovery strategies.   

 

     

                                                 
21

 Cutter, S.L. (2008). Cutter, S.L.; Mitchell, J.T.; and M.S. Scott. (2000; 1997).  NOAA: CSC. (2010b; 1999); 

PSDS. (2001). Thieler, E.R and E.S Hammar-Klose (1999); Lennon et al (1996); Gornitz, V. M., Daniels, R. C., 

White, T. W., and Birdwell, K. R. (1994). 

Figure 2: Coastal Community Vulnerability 

Assessment Protocol 
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Getting to Resilience 

Getting to Resilience (GTR) is a facilitated questionnaire that was developed as a non-regulatory 

tool to assist local decision-makers in the collaborative identification of planning, mitigation, and 

adaptation opportunities to reduce vulnerability to coastal storms, flooding and sea level rise, 

thus building capacity for coastal community resilience. As noted previously the Getting to 

Resilience Questionnaire was envisioned to work in conjunction with the mapped information 

provided through the CVI and CCVAMP initiative. The questionnaire incorporates the key 

components of existing local government evaluation tools, developed by academics, international 

and federal agencies, and planning practitioners to improve community resilience to natural 

hazards, including, but not limited to, elements from the National Flood Insurance Program’s 

Community Rating System and the MS/AL Sea Grant’s Community Resilience Index.   While this 

questionnaire incorporates many concepts and questions from existing tools, it is not intended to 

grade the resiliency of a community.  It is however intended to start a dialogue among various 

decision-makers, spawning creative thinking and collaboration between plans and on ways for 

their community to become more resilient for existing and future generations.   

 

The questionnaire highlights the importance of local plan 

integration and consistency with municipal building codes, 

ordinances and zoning to seamlessly support flood 

protection efforts.  

 

The questionnaire is divided into five sections: 

  

(1) Risk and Vulnerability Assessments, 

(2) Public Engagement, 

(3) Planning Integration, 

(4) Disaster Preparedness and Recovery, and 

(5) Hazard Mitigation Implementation. 

 
   
In order to initiate information sharing and spawn 

collaborative decision-making, the facilitation of the 

questionnaire should include but not be limited to, elected 

and appointed officials, land use planners, hazard mitigation 

planners, floodplain managers, emergency managers, 

stormwater engineers, and natural resource planners.  The 

Getting to Resilience questionnaire should be facilitated in a 

roundtable discussion and commence with a review of 

available vulnerability assessments and/or the results of CCVAMP.  Participants will then be 

fully aware of the hazards their community faces when assessing its resilience.  

 

While this document does not include the Getting to Resilience questionnaire, it can be obtained 

by contacting the New Jersey Office of Coastal Management.  

Figure 3: Getting to Resilience 

Questionnaire 
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Coastal Community Vulnerability Assessment and Mapping 
Protocol: Cookbook Approach 

The NJOCM is presenting this document in a ‘cookbook format’ to help guide the assemblage of 

the data layers and development of maps and assessment tools. The following sections will 

outline the data required to perform the CCVAMP and give a few example maps. A detailed 

methodology (Cookbook) for creating your own Coastal Vulnerability Index, Assessment and 

Maps can be found in Appendix A: Building a Coastal Vulnerability Assessment: A Technical 

Guidance. Each section is hyperlinked to the appropriate ‘mapping protocol’ in Appendix A. 

 

The CCVAMP is designed to help coastal communities navigate the process to generate a 

geospatial hazard and vulnerability assessment.  The maps generated by a hazard assessment can 

increase awareness of vulnerable infrastructure, environmental resources, and populations that lie 

in high hazard areas, providing decision-makers with the information to adapt, mitigate, and plan 

for response and recovery to current risks and future hazard scenarios. CCVAMP is a two-part 

mapping process that requires the development of hazard maps and the identification of 

vulnerable community assets, natural resources, and people. This document attempts to define 

some of the mapping procedures that a community should pursue when developing a hazard and 

vulnerability assessment.   

      

What Does It Take to Develop a Geospatial Coastal Vulnerability Assessment?  

 Expertise:  Geographic Information Systems Specialist with raster modeling capabilities 

 Software:  ArcGIS 9.2 or higher and Spatial Analyst Extension  

 Computer:  High performance computer, especially for large scale assessments 

 GIS Data:  Geospatial data representing community assets, natural resources, and social 

vulnerable populations, some of which sources are noted throughout this document 

 

Prior to developing new hazard maps, a community should identify if there are existing maps 

and/or assessment available through the state or the county.  In many cases, storm surge maps are 

available from the State Office of Emergency Management or a county emergency management 

office, and floodplain maps are available within each municipality. While these maps typically 

do not provide the necessary level of detail to perform a local vulnerability assessment, some 

communities may solely have to rely upon such maps  due to a lack of GIS staff or consultants.  

For those communities that do have GIS mapping capabilities, they should consider pursuing the 

development of multiple inundation scenarios, including spring tide, storm surge, and sea level 

rise. They should also consider the development of a coastal vulnerability index or 

environmental constraint model to geospatially identify land areas that are susceptible to multiple 

hazard scenarios.  A community can then assess the potential hazard exposure of infrastructure 

and development, natural resources and environmental concerns, and vulnerable sectors of the 

population. The following sections of this document will define suggested mapping 

methodologies to follow when developing a risk and vulnerability assessment. 
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Publically Available Data & Tools 

The New Jersey shore has historically been heavily impacted by coastal storms, flooding, and 

erosion. It is important for coastal communities to build upon past experiences to help identify 

current and future hazard vulnerabilities.  Inundation and hazard mapping play a large role in 

helping a community understand its risks and vulnerabilities, and should be one of the first steps 

taken to help a community become more resilient to coastal hazards. To obtain a full 

understanding of inundation threats of current and future climate conditions, the NJOCM 

suggests that communities develop multiple inundation scenarios. Through a collaborative 

process, municipal leaders and staff should identify which inundation scenarios to consider in an 

assessment, along with the appropriate scale of the analysis.   
 

NOAA Coastal Services Center’s Coastal Inundation Mapping Guidebook defines the 

methodologies to model shallow coastal flooding, storm surge, and sea level rise.
22

 The NJOCM 

recommends using Light Detecting and Ranging (LiDAR) derived digital elevation models 

(DEMS) as the topographic baseline for the development of the inundation models and hazard 

indexes. To ensure that inundation models are meaningful and represent realistic worst case 

scenarios, the NJOCM recommends the use of NOAA’s Vertical Datum Transformation Tool 

(VDatum)
23

 to adjust elevation data from NAVD88 to an appropriate tidal datum.  Because there 

are multiple steps involved in developing inundation scenarios, NOAA Coastal Service’s Center 

provides training on mapping methodologies and inundation visualization to ensure that coastal 

managers and local decision-makers have the necessary tools and baseline knowledge to develop 

local hazard maps.
24

 By leveraging these innovative resources, New Jersey coastal communities 

will be better equipped to identify storm and inundation threats, allowing them to plan and 

prepare for potential adverse impacts to infrastructure and development, cultural and historic 

places, natural resources, and other locally significant assets.   

 

Topography and Shoreline 

LiDAR 

Elevation was identified as one of the most influential factors affecting vulnerability of the 

coastal landscape. Elevation defines flood patterns, the likelihood for coastal erosion, and 

potential development constraints. Because accurate elevation data can influence coastal 

management, long-range planning, and hazard mitigation, high resolution elevation data, 

otherwise known as Light Detecting and Ranging elevation (LiDAR), is recommended for a 

variety of purposes, including, but not limited to, vulnerability mapping, storm surge and sea 

level rise modeling, floodplain mapping, land suitability analysis, and shoreline mapping.   

 

In 2007, the NJOCM began the process of identifying the necessary data to understand changes 

and vulnerability along the Delaware Bayshore. Using LiDAR technology, the NJDEP acquired 

2-meter resolution elevation data with a vertical precision of ± 15 centimeters (6 inches).  Data 

was contracted to be collected within ± 3 hours of mean low water to capture the topography of 

the intertidal zone, which will allow for the delineation of the Bay’s shoreline. The LiDAR 

                                                 
22

 NOAA: CSC. (2009). http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf   
23

 NOAA: NGS. (2010). 
24

 NOAA: CSC. Inundation Toolkit. http://www.csc.noaa.gov/digitalcoast/inundation/   

http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf
http://www.csc.noaa.gov/digitalcoast/inundation/
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acquisition was funded through partnerships with NOAA (NJCZM Grant), NJDEP (OIT), Office 

of Homeland Security and Preparedness, US EPA Region 2, USDA NRCS, USACE Philadelphia 

District, and USGS.  
 

Figure 3: 10-Meter v 2-Meter Resolution Elevation Data 

Today, bare-earth LiDAR digital elevation models (DEMs) are available for every coastal county 

in the state. While tides were not considered in the acquisition of elevation data in Atlantic 

coastal counties, a great deal of analysis and inundation modeling can be done using the 

available data. As technology and mapping standards continue to improve, New Jersey should 

continue to pursue the attainment of best available elevation data with consistent acquisition 

standards that allow for the development of a seamless coastal DEM and digitally represented 

shoreline. LiDAR data is available from multiple sources, including: 
 

 NJDEP Bureau of Geographic Information Systems (available by request) 

 USGS Seamless Server http://seamless.usgs.gov/ 

 USGS Center for LiDAR Information Coordination and Knowledge (CLICK) 

http://lidar.cr.usgs.gov   

 NOAA’s Digital Coast http://www.csc.noaa.gov/digitalcoast/data/coastallidar/download.html 

VDatum 

In order to adequately visualize the inundation impacts of shallow coastal flooding, storm surge, 

and sea level rise, elevation data should be referenced to a tidal datum.  Doing so will allow 

inundation scenarios to be represented at a preferred tidal stage, such as mean high water or 

mean higher high water.  NOAA’s National Geodetic Survey (NGS), Office of Coast Survey 

(OCS), and Center for Operational Oceanographic Products and Services (CO-OPS) developed 

the Vertical Datum Transformation Tool (VDatum) to vertically transform geospatial data 

among a variety of tidal, orthometric and ellipsoidal vertical datums.
 25

  Because New Jersey 

elevation data is typically referenced to North American Vertical Datum of 1988 (NAVD88), the 

NJOCM suggests converting digital elevation models into a tidal datum.  By doing so, storm 

surge and sea level rise models can be represented at various tidal stages, preferably mean higher 

high water (mhhw) to represent worst case scenarios.  VDatum can also be used to model scenarios 

at mean lower low water, which may be useful when mapping predicted water elevations, like future 

                                                 
25

 NOAA. NGS. (2010). 

10-meter resolution digital 

elevation models were formerly 

the best available elevation 

data (left). LiDAR provides 

higher quality elevation data 

(right) which generates more 

accurate digital elevation 

models (DEMs).    

 

http://seamless.usgs.gov/
http://lidar.cr.usgs.gov/
http://www.csc.noaa.gov/digitalcoast/data/coastallidar/download.html
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spring tides. Visit the VDatum website (http://vdatum.noaa.gov/) to learn how to apply the 

transformation tool to elevation data in your area of interest.    

Shallow Coastal Flooding and Past Storm Events 

New Jersey coastal communities often experience coastal flooding in low-lying areas during spring 

tides, nor’easters, and hurricanes. In order to understand inundation patterns from past storm events 

or spring tides, visit NOAA’s Tides and Currents website (http://tidesandcurrents.noaa.gov/) to 

locate the tide gauge closest to your area of interest.  Explore the tabs and information that are 

available on this website.  It not only provides future tide predictions, it has records of past tidal 

records.  To identify the highest water elevations recorded near your community: (1) Pick a tide 

station closest to you, (2) chose “Extremes,” (3) from the drop down menu, select “Station 

Extremes-Report,” (4) choose a broad range of dates, and (5) Click “Apply Change.”  A list of 

extreme tide events, along with the dates will appear.  

Identify the date of the worst tide event.  In most cases, 

the date will correspond with Hurricane Donna (1960), 

the December 1992 Nor’easter, or Hurricane Irene 

(2011).  Identify the date of the worst event, and select 

the “Verified Data” option. On this webpage, input the 

date of the identified event, choose “Hourly” as the 

Interval, and select “mllw” as the Datum.  To the right 

is an example of the results from the Sandy Hook tide 

station for Hurricane Irene, which identifies the 

maximum water elevation as 9.75 feet above mllw. To 

visualize this inundation pattern in a map of Sandy Hook, ensure that the elevation data is in feet 

and has been adjusted to mean low lower water, using VDatum.  In ArcMap or Arc Catalog, use the 

raster calculator under the Spatial Analyst extension to identify all elevations in the DEM below 9.75 

feet.  (Example expression: [MLLW_DEM] <= 9.75)  This will generate a data layer showing the 

likely inundation pattern that occurred during Hurricane Irene in Sandy Hook.  By utilizing 

NOAA’s Tides and Currents website, a coastal community can also identify the tidal depths of 

past spring tide events, which occur during new and full moons.  Note that the highest tides of 

the year typically occur during the spring and fall equinoxes (March 20/21 and September 

22/23). Following the same steps as before, a coastal community can then model the inundation 

patterns of past spring tides.  

   

Figure 4: Water Depths from Sandy Hook 

During Hurricane Irene 

 
This graph represents the variation in the predicted water elevation and the observed water elevation 

during Hurricane Irene, indicating a storm surge of approximately 5 feet near Sandy Hook, New Jersey. 

Source: NOAA. (2011). Tides and Currents, Historic Tide Data 

 

Figure 5: Water Elevations at Sandy Hook During Hurricane Irene 

http://vdatum.noaa.gov/
http://tidesandcurrents.noaa.gov/


 

 

 
13 

Storm Surge Inundation 

The New Jersey coast has experienced multiple tropical 

storms and low-grade hurricanes since the 1850s.
26

  While 

the Shore has been spared the catastrophic impacts of a 

major hurricane, changes in climate could produce more 

intense and frequent storm events. The Sea, Lake and 

Overland Surges from Hurricanes (SLOSH) Model and 

Advanced Circulation (ADCIRC) Model are two types of 

storm surge models that can be applied to elevation data 

to visualize inundation scenarios.  The NJOCM 

recommends using the SLOSH model because it is readily 

available and updated by the National Hurricane Center 

(NHC).  SLOSH estimates storm surge heights and winds 

resulting from historical, hypothetical, or predicted 

hurricanes by taking into account pressure, size, forward 

speed, storm track, and winds.
27

 The SLOSH model is run 

for a large number of storm scenarios (directions, speed, 

etc.) to determine maximum storm surge for each 

hurricane category. The NJOCM recommends 

downloading MOM shapefiles (Maximum of the 

MEOW), which reflect the Maximum Envelope of Water 

(MEOW) for thousands of storm scenarios.  The MOM 

Model is a composite of the maximum storm surge height 

for all hurricanes of a given category.  This scenario-

based approach is used in evacuation studies, and is ideal 

for planning and mitigation purposes.   

 

Visit the NHC’s SLOSH Display Package website 

(http://slosh.nws.noaa.gov/sloshPub/disclaim.php) to 

download training information and grid shapefiles of 

surge elevations.  There are five basin models to choose 

from for a local analysis, including basins for Ocean City, 

MD, the Chesapeake Bay, the Delaware Bay, Atlantic 

City, and New York City.  These grid basins should be 

transformed from NAVD29 to NAVD88 before applying 

them to LiDAR data.  After adjusting the elevation data to 

the appropriate datum, follow the procedures defined in 

the Coastal Inundation Mapping Guidebook to map 

inundation scenarios and identify vulnerabilities within 

your community.   
 

                                                 
26

 NOAA: CSC. (2010a). 
27

 NOAA: NHC. (2011) 

 

 
Waves Pound the beach at Asbury 

Park during Hurricane Irene   
Photo Credit: Chip East, Reuters 

 

 

 
Firefighters battle a fire at 484 Brielle 

road in Manasquan after Irene  
Photo Credit: Andrew Mills/The Star-Ledger 

 

Hurricanes have the capability to 

damage and destroy coastal properties 

and threaten the lives and livelihoods 

of coastal residents.  New Jersey was 

fortunate to avoid major coastal losses 

during Hurricane Irene. Emergency 

management efforts ensured that the 

coastal zone was evacuated in adequate 

time and coastal residents and 

businesses heeded the warnings of the 

state and federal government.  Taking 

precautionary actions and planning 

ahead were key to ensure the safety and 

resilience of New Jersey coastal 

residents and industries.   

 
 

http://slosh.nws.noaa.gov/sloshPub/disclaim.php
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Map 3: Storm Surge Map of the Delaware Bay 
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Sea Level Rise Inundation 

Over the next century, sea levels are predicted to rise 

between 0.5- 1.5 meters (~1.6 - 4.9 feet) along the New 

Jersey shore, threatening coastal development and 

natural resources.  While local planning horizons are 

typically on a 10 to 20 year cycle and infrastructure 

budgeting spans a 50 year time scale, the impacts of 

natural processes, like shoreline change and sea level 

rise, typically occur over an extended period of time.  

Prior to making substantial budget decisions, coastal 

communities should consider the threat of sea level rise 

on existing and proposed infrastructure, development 

and land use, and open space conservation.  
 

While there are numerous sea level rise projections 

available, the NJOCM suggests that communities utilize 

a 0.5, 1.0, and/or 1.5 meter scenario when modeling sea 

level rise. There are multiple ways that a community can 

visualize the potential inundation threats associated with 

sea level rise.  A Bath Tub Model is a simple model that 

utilizes a digital elevation model to determine land areas 

that lie below a particular elevation contour. To create 

such a model, one can either convert a LiDAR DEM 

from NAVD88 to a MHHW tidal datum prior to 

performing the inundation analysis or create a ‘generic’ 

MHHW zero raster and convert this to NAVD88 using 

V-Datum.  Sea level rise models can also be applied on 

top of spring tide scenarios to reflect the inundation 

extent of future spring tides       

 

While a Bath Tub Model may be useful for planning or 

infrastructure purposes, there are other assessments that 

are typically used to analyze sea level rise impacts on 

habitat, including the Sea Level Affecting Marshes 

Model (SLAMM).
28

  SLAMM is a wetland migration 

model that simulates the impact of sea level rise on 

coastal land classifications.  It combines elevation data 

with wetland classifications, erosion rates, subsidence 

rates, tidal data, and dike and levee data with user 

defined sea level rise scenarios and timeframe intervals 

to simulate changes in the coastal landscape due to sea 

level rise.  Utilizing SLAMM can improve the 

understanding of climatic changes on shorelines and 

habitat.   

                                                 
28

 Clough, J. (2010). 

 
Saltwater Intrusion 
Photo Credit: Mary Judge 

 

The impact of saltwater intrusion  into 

the shallow water table can  already 

be seen along portions of the New 

Jersey coastline, especially where 

dead trees mark the transition line 

between tidal wetlands and upland 

forests.   As sea level rise accelerates, 

freshwater wetlands and fringing 

forests will become highly susceptible 

to the impacts of sea level rise.  The 

Partnership for the Delaware Estuary 

has applied the SLAMM model along 

portions of the Delaware Bay.  Visit 

the following website for more 

information: 

www.delawareestuary.org/  

 

Sea level rise modeling can inform 

coastal decision-makers and wildlife 

managers about the conditions that are 

conducive to the landward migration 

of coastal wetlands, the development 

of pioneering coastal wetlands along 

open water areas, and the 

transformation of freshwater wetlands 

to tidal wetlands.  Understanding how 

the natural environment may react to 

changes in sea level will inform 

adaptation measures like natural 

shoreline stabilization and acquisition 

of conservation land.   

http://www.delawareestuary.org/
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Map 4: Sea Level Rise Map of the Delaware Bay 
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Coastal Vulnerability Index 

Storm surge and sea level rise maps may help coastal communities visualize flooding threats, but 

inundation mapping alone does not clearly define most high risk areas in and around a 

community.  Historic flooding and erosion, combined with potential inundation areas and natural 

features of the landscape help a community determine where property damages and 

environmental impacts are likely to occur the next time around. Creating an index whereby a 

“baseline of natural risk” is mapped, community decision makers can start to understand the 

potential risk to critical 

infrastructure, natural resources, and 

populations. In order to delineate 

high hazard areas, the New Jersey 

Office of Coastal Management 

developed a composite overlay 

model of six geospatial hazard 

indicators, including 

geomorphology, low slopes, flood 

prone areas, storm surge inundation 

scenarios, poorly drained soils, and 

erosion prone areas.  This model is 

known as a Coastal Vulnerability 

Index (CVI) and is based on 

previous vulnerability modeling applications.
29

  The CVI can help land use planners and hazard 

mitigation planners identify areas of highest development constraints due to natural conditions 

that are indicative of flooding and erosion.  The CVI can be used as an environmental constraint 

model to determine land suitability for future development and zoning classifications.  It can also 

be used to help identify mitigation opportunities in high hazard areas, in addition to areas where 

engineering and climate adaptation may prove to be extremely difficult or ineffective.   

 

Note: While highly recommended the CVI is not an essential part of a full hazards profile or 

vulnerability assessment. Therefore, if resources and/or expertise are such that a CVI cannot be 

performed effectively, it can be left out. 

 

It is important to understand that the CVI created by the NJOCM represents one method of 

assessing natural risk, and therefore could be modified by adding additional layers and/or 

weighting attributes of those layers such that the sum of the parts more accurately depicts factors 

of regional importance. For instance, CVI is merely a static model that represents lands that are 

presently vulnerable to inundation and erosion, but it can be adapted to incorporate sea level rise 

scenarios into existing storm surge models to visualize how climate change may move high 

hazard areas further inland overtime.  By understanding the vulnerabilities that presently exist in 

coastal New Jersey, along with potential changes in future conditions, communities will have the 

opportunity to mitigate existing development and guide future decision-making in a more holistic 

and sustainable manner.    

                                                 
29

 Gornitz, V. M.; Daniels, C. R.; White, T. M., and K. R. Birdwell. (1994); Lennon et al. (1996); Thieler and 

Hammar-Klose (1999); Bush, D.M.; Neal, W. J.; Young, R.S.; and O.H. Pilkey (1999); PSDS. (2001).  

 

CVI = a + b + c + d + e + 

f 

Figure 6: Coastal Vulnerability Index Model 
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Map 5: Coastal Vulnerability Index Map of the Delaware Bay 
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Slope   

The terrain of a coastal region can greatly impact its vulnerability to periodic flooding and sea 

level rise.  Utilizing available LiDAR, land areas below 2 percent slope were identified as 

vulnerable.  As slope decreases, more land areas become prone to pooling of water, allowing for 

prolonged coastal flooding.  Theoretically, the Brunn Rule indicates that every foot rise in water 

will result in a 100 foot loss of sandy beach, whether it is an episodic storm event or permanent 

inundation due to sea level rise.  In other words, a 1 percent slope or less is likely to be inundated 

with a 1 foot rise in water.  While the Brunn Rule does not apply to all land types, it provides 

insight that low-lying coastal areas are most vulnerable to inundation and changing coastal 

conditions.  Looking at the map below, it is evident that coastal wetlands and beaches coincide 

with the very high classification.  

 

Map 6: SLOPE Ranking along the Delaware Bay 
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Flood Prone Areas 

FEMA’s Flood Insurance Rate Maps (FIRM) are the most accessible digital flood information 

available to municipal officials. While FEMA is in the process of generating updated flood maps 

for coastal New Jersey, communities can supplement their knowledge by using existing soils 

data to identify flood prone lands.  The DFIRM Q3 Maps were used as the basis for the analysis 

and rank of the attributes according to level of risk.  The V-Zone should be ranked as the most 

risk prone, while the 100-Year Floodplain and the 500-Year Floodplain should be identified as 

high to moderately risk prone.  Where shorelines have shifted and lands have accreted since the 

Q3 maps were developed, utilize the ranking of the floodzone adjacent to it, typically a V-Zone 

or A-Zone.  For the land areas that are outside of designated floodzones, utilize soils data 

(SSURGO, flodfreqmax) to identify soils that have a high to occasional likelihood of flooding in 

a given year.  

 

 
   Map 7: Flood Prone Areas along the Delaware Bay 
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Drainage 

Soil drainage influences the period of time coastal lands are inundated after a storm event. While 

highly drained soils typically consist of sands and porous sediments, poorly drained soils are 

typically wetland soils or clays.  Using soil data from USDA NCRS (SSURGO, drclassdcd), 

rank soils from well drained to very poorly drained. ‘Somewhat excessively drained’ and 

‘excessively drained’ soils should not be considered in this analysis because they are not 

vulnerable to extended inundation.  While well drained soils can decrease vulnerability, be aware 

that there may be an inverse relationship with erodible soils because well drained soils are 

typically associated with sand.   

 

Map 8: Soil Drainage along the Delaware Bay 
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Erosion 

There are multiple ways to assess erosion risk.  Communities should use erosion data that are 

available to them, which many require erosion rates of coastlines to be projected into the future 

to fully assess erosion risk.  Because erosion analysis has not been done for all shorelines and 

shoreline types in New Jersey, communities can utilize existing datasets available to them, 

including erodible soils data (SSURGO, kffact) and historical shoreline data. The soils data 

should serve as the basis of the erosion model.  Rank the kffact scores, which represent the 

susceptibility of soil particles to detachment by water.  Most of the Delaware Bay is 28 to 43 

percent susceptible to erosion due to water.  Note that there are gaps in the data. Where there is 

an obvious correlation between adjacent soils, utilize the adjacent classification.  Where there is 

not an obvious correlation, rank the area as 0.  To supplement the soils data, utilize historic 

shoreline data to identify beachfront areas that have a history of erosion or accretion.  Areas of 

historic erosion should be classified as very high. Areas of historic accretion should be classified 

as 5 because those land areas are susceptible to change.   

 

Map 9: Erosion Classifications 

 
 

  



 

 

 
23 

Geomorphology   

The New Jersey shore is comprised of multiple geomorphic settings because of varying wave, 

current, and wind energy that exists along the coast.  There are seven distinctive shoreline types 

along the Jersey shore, including spits, high and mixed-energy barrier island systems, headlands, 

bays and open bay systems, tidally influenced, freshwater rivers and estuaries.  These shoreline 

types are indicative of the natural hazards and geologic processes that have shaped them over 

time. Geomorphology should be included in large-scale assessments, but may not be necessary in 

coastal communities because they typically represent one geomorphic region.  The NJOCM 

delineated multiple geomorphic classifications along the New Jersey shore by identifying the 

watersheds that are tidally influenced and labeling them with the geomorphic description shown 

in the New Jersey Shore Protection Master Plan.  Based on anecdotal information, each 

geomorphic region was ranked for its vulnerability to coastal hazards and sea level rise.   

 
Map 10: Geomorphic Regions along the Delaware Bay 
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Storm Surge 

Storm surge inundation patterns are not usually well represented in flood plain maps. To 

understand the potential for inundation, communities should apply the National Hurricane 

Center’s SLOSH Model, coupled with a MHHW scenario, to understand the worst case scenario 

of any storm event. MHHW represents the daily extent of tidal inundation and is obviously the 

most vulnerable area. The inundation of a category one storm would be classified as the high, 

followed by the inundation extent of a category two hurricane, etc.  These storm scenarios are 

ranked this way because a category one storm is most likely to occur.  Additionally, if a category 

four storm impacted the Shore, the inundation will be worst in low-lying areas.   

 

 

  

     Map 11: Storm Surge (SLOSH) along the Delaware Bay 
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Vulnerability Analysis 
Maps of hazard prone areas are informative in themselves, but local decision-makers should be 

aware of the community assets that lie within these areas to guide policy and planning. The 

vulnerability analysis within each community will not be the same, as each community will 

likely be concerned with assessing different assets that are vital to its functioning and character.  

The input of community leaders and the public on the types of assets to assess vulnerability not 

only engages stakeholders in the assessment, it can build community consensus around the 

mapping results.  Participatory mapping is one way to engage stakeholders in the vulnerability 

assessment.  NOAA Coastal Services Center’s “Stakeholder Engagement Strategies for 

Participatory Mapping” provides guidance on how to conduct this form of community outreach 

and information gathering.
30

 Information gathering may occur in the form of public workshops 

or meetings.  During these public programs, members of the assessment team may wish to utilize 

checklists of known community assets to consider for a geospatial vulnerability assessment.  The 

assessment team can then accurately identify and map significant features of the built and natural 

environment, in addition to social characteristics, that intersect various inundation and hazard 

scenarios.  Municipal leaders can use this information to inform mitigation and adaptation 

strategies and guide dialogue during the facilitation of the Getting to Resilience questionnaire.  

The following pages provide some examples of the types of community assets, natural resources, 

and social characteristics that a community may want to consider in a vulnerability assessment, 

along with available GIS resources to utilize during the mapping process.   
Figure 7: Example of a Vulnerability Mapping Considerations Checklist 

 

  
                                                 
30

 NOAA. (2009). 
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Built Environment Vulnerability 

Coastal communities should assess the vulnerability of 

multiple types of infrastructure and community assets to 

coastal storms and sea level rise, including lifelines and 

critical infrastructure, community facilities, economic 

centers, historic and cultural facilities, and recreational 

destinations.  Critical infrastructure and lifelines are the 

facilities or networks that are inherent to the functioning of 

a community. Examples of lifelines include roads and 

evacuation routes, emergency shelters, and hospitals.  The 

failure or interrupted service of these lifelines can 

endanger the health, safety, and welfare of a community’s 

citizens, interrupt disaster response, and result in property 

damage and the loss of lives.  In addition to assessing the 

vulnerability of critical infrastructure, communities are 

urged to assess how its community facilities will be 

impacted by coastal storms and changes in sea level.  

Community facilities include, but are not limited to, 

municipal offices, schools, houses of worship, and 

community centers.  Other forms of infrastructure that 

affect the character, economy, or quality of life of coastal 

communities include historical and cultural facilities, 

business centers, and recreational facilities.   

 

Municipal officials should have a clear understanding of 

the vulnerable infrastructure and assets that exist within 

their community.  It is not feasible to assess the structural 

vulnerability of all facilities, so a community should begin 

a vulnerability assessment by identifying facilities and 

networks that are likely to be exposed within areas of high 

coastal vulnerability.  After identifying infrastructure and 

assets that may be exposed to coastal hazards, a local 

government can then conduct further investigations, 

including engineering and code inspections, to determine if 

there are structural or operational vulnerabilities that may 

need mitigation. While many forms of infrastructure may 

not be vulnerable under present conditions, coastal storms 

coupled with an increase in sea level rise have the potential 

to inundate land areas that are not presently identified 

within flood hazard areas.  By identifying vulnerable 

infrastructure, municipal officials can then determine 

mitigation options for existing facilities and ensure that 

new infrastructure is built away from high hazard areas, 

using higher construction standards.  

 

 

 
Hurricane Floyd Recovery, 1999 
Location: Bridgewater 

Photo Credit: Andrea Booher, FEMA 
 

Contaminated water purification 

systems and well water can have an 

immense impact on a community’s 

ability to rebound quickly from a 

disaster.   
 

 

Nor’Ida, Fall 2009 
Location: Seaside Heights 
www.theweatherchannel.com 
 

The economic centers of shore 

communities are often situated in 

close proximity to the water, making 

them vulnerable to the impacts of 

erosion, coastal storms and sea level 

rise.     
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Built Environment Considerations 
There are multiple types of infrastructure that a community may wish to assess the vulnerability 

of in regards to coastal storms and sea level rise.  A community may wish to first assess the 

vulnerability of its lifelines, but it should also consider assessing the vulnerability of additional 

community facilities that impact the ability to respond and recover from a disaster, such as 

schools, houses of worship, nursing homes, mental care facilities, and prisons.  In addition, a 

community should consider assessing economic sectors, business districts and cultural resources.  

Below are some examples of the built environment that may be considered when conducting a 

vulnerability assessment.  By assessing and mitigating the vulnerabilities of these facilities, a 

community can improve their overall resilience to coastal storms and climate change. 

Infrastructure data can be obtained from numerous sources, including TigerLine, FEMA’s 

HAZUS-MH (v.1.4, DVD 6), and local GIS and planning offices.   

 

Lifelines and Critical Infrastructure 

 Evacuation Routes 

 Interstates and Roads 

 Bridges and Tunnels 

 Emergency Shelters, Human and Pet 

 Military Facilities 

 Police and Fire Stations 

 Public Works 

 Hospitals 

 Mental Care Facilities 

 Nursing Homes 

 Homeless Shelters 

 Prisons 

 Airports 

 Dams and Levees 

 Radio Towers 

 Power Supply 

 Water and Sewer Treatment 

Facilities 

 Railroads and Rail Bridges 

 Ports 

 Ferries 

 

Community Facilities 

 Municipal Offices/Town Hall 

 Schools 

 Houses of Worship 

 Community Centers 

 Libraries 

 Business Districts 

 Shopping Centers 

 

Historic and Cultural Facilities 

 Landmarks 

 Historic Homes and Sites 

 National Register Sites 

 Historic Districts 

 Museums 

 

Recreational Facilities 

 Parks 

 Public Access Sites 

 Boardwalks 

 Piers 

 Marinas 
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Natural Environment Vulnerability  

Coastal hazards and sea level rise threaten the natural 

resources of the New Jersey coast, not only the habitat 

and species within the coastal zone, but the scenic and 

recreational resources that draw people to the shore as 

well.  Coastal storms have the ability to impair or destroy 

habitat, cause saltwater intrusion into freshwater 

ecosystems and resources, and allow pollutants to 

degrade water quality and affect public health.  

Fortunately, many of these impacts subside with time, 

habitats restore, and most species eventually recover 

from the impact of coastal storms.  However, over time, 

climate change will heighten the threat of coastal hazards 

by increasing the intensity and frequency of coastal 

storms, erosion, and inundation, while decreasing 

recovery intervals between events.  Rising seas are 

expected to continue to encroach upon beaches and tidal 

wetlands, but at a much faster rate than has been 

experienced during the twentieth century.  Beaches and 

wetlands will be incapable of ‘keeping  pace’ with sea 

level rise, especially where coastal development and 

shoreline stabilization structures inhibit shoreline 

migration.  While this poses some obvious threats to 

habitat and native species, some less obvious impacts 

may include saltwater intrusion, loss of sediment and 

increases in non-point source pollution.    

 

Coastal hazards, sea level rise, and other climate change 

impacts not only threaten coastal landscapes, they 

threaten the long-term resiliency of many coastal 

communities by negatively impacting public health, 

various economic sectors, and quality of life.  To help 

the coastal environment keep pace with coastal hazards 

and sea level rise, decision-makers will need to advocate 

for and implement adaptation and mitigation measures.  

In some cases, open space and easements may be 

acquired to allow habitats to naturally migrate inland 

with rising seas. In other cases, mitigation may be 

necessary to reduce the threat of man-made hazards on 

the environment by remediating hazardous waste sites, 

replacing septic tanks with sewer services, and relocating 

waste disposal sites.  Identifying vulnerable natural 

resources is the initial step to understand the threat of 

coastal hazards and sea level rise. 

 

 

Horseshoe Crabs 
Photo credit: Lawrence Niles, PhD  

 

The New Jersey coastal zone is home to 

more than 24 state designated 

endangered and threatened species.  

Among them is the Red Knot, a 

migratory bird species that relies upon 

horseshoe crab eggs to sustain itself 

during its journey from South America 

to the Arctic.  The Delaware Bay serves 

as the largest spawning ground in the 

world for horseshoe crabs, making it an 

essential stopover for over 1.5 million 

shorebirds.  Loss of sandy beaches due 

to erosion, coastal storms, and sea level 

rise threaten the spawning grounds for 

horseshoe crabs and a valuable food 

source for migratory birds.    

 

 
Red Knot 
Photo Credit: Lawrence Niles, PhD 

http://www.state.nj.us/dep/fgw/ensp/pdf/shr

brdfuture.pdf  

 

http://www.state.nj.us/dep/fgw/ensp/pdf/shrbrdfuture.pdf
http://www.state.nj.us/dep/fgw/ensp/pdf/shrbrdfuture.pdf
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Natural Environment Vulnerability Considerations  
There are numerous environmental features and vulnerabilities that a community or special 

interest group may want to consider when performing a vulnerability assessment.  The features 

listed below encompass just a few types of geospatial features that could be assessed when 

determining coastal hazard and sea level rise vulnerability.  While a community may want to first 

assess the vulnerability of natural resources that impact public health or those that influence 

economic sectors, research scientists and wildlife biologists may be more inclined to assess the 

impacts of coastal hazards and sea level rise on particular habitat types and species.  Such an 

analysis may require the application of a more in depth vulnerability assessment, like Nature 

Serve’s Climate Change Vulnerability Index
31

 or SLAMM.
32

  And a combination of habitat and 

sea level rise mapping can help identify the potential impacts of climate change on ecosystem 

services.  Understanding the capabilities of various assessments will prove to be useful when 

determining the type of vulnerability mapping to perform; which will then provide insight on 

mitigation and adaptation opportunities.  The following are examples of natural resources, 

habitat, and man-made hazardous contaminants that could be considered during a vulnerability 

assessment.  Natural resource GIS data can be obtained from multiple sources, including 

NJDEP-GIS (http://www.state.nj.us/dep/gis/) and many federal agencies.   

 

                                                 
31

 Climate Change Vulnerability Index:  http://www.natureserve.org/prodServices/climatechange/ccvi.jsp  
32

 SLAMM: http://warrenpinnacle.com/prof/SLAMM /   

Hazardous Contaminants 

Superfund and Brownfield Sties 

Hazardous Waste Sites 

Manufacturing Sites 

Petrochemical Sites 

Landfills 

Drycleaners 

Wastewater Treatment Plants 

Sewage Treatment Facilities  

Habitat of Species of Special Concern 
 
Water Resources 

Aquifer Recharge Areas 
 
Agriculture 

Aquaculture Sites 

Farmland of Statewide Importance 

Timberlands 
 
Conservation Lands 

National and State Parks 

Coastal and Estuarine Land Conservation 

Wildlife Management Areas 

Fish and Wildlife Refuges 

Green Acres Land 
 

Blue Acres Land 

Conservation Easements 
 
Habitat 

Saltwater Wetlands/Marshes 

Freshwater Wetlands 

Brackish Rivers, Streams, and Creeks 

Freshwater Rivers, Streams and Creeks 

Beach and Dune Systems 

Forestlands 

Environmentally Sensitive Areas 

Wildlife Corridors 

Migratory Bird Nesting Areas 

Federally Threatened and Endangered 

Species 

State Threatened and Endangered 

Species 
 
Natural Capital 

Ecosystem Services Values 
 

http://www.state.nj.us/dep/gis/
http://www.natureserve.org/prodServices/climatechange/ccvi.jsp
http://warrenpinnacle.com/prof/SLAMM%20/
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Social Vulnerability 
The socio-economic composition of coastal communities 

varies throughout the State of New Jersey from densely 

populated, seasonal communities along the Atlantic coast 

to the rural, agricultural communities of the Delaware Bay.  

Because Shore communities vary in size and development 

patterns, the socio-economic factors that influence their 

resilience and adaptability to coastal storms and sea level 

rise vary as well.  Some communities may consist of a 

large number of retirees or disabled residents, while others 

may be comprised of a large number of immigrant 

households or poverty stricken families.  Identifying where 

vulnerable populations live in relationship to high hazard 

coastal areas can inform community leaders and 

emergency management officials where to target flood and 

storm preparedness, public outreach, and evacuation, 

recovery and mitigation assistance.  By providing public 

outreach and reducing the exposure of vulnerable 

populations to natural hazards, communities can improve 

their overall resilience to coastal storms and inundation.   

 

There are multiple ways that a community can identify 

where vulnerable populations live in relationship to high 

hazard areas.  For the purposes of a hazard vulnerability 

assessment, the NJOCM defines socially vulnerable 

populations as individuals who may be unaware of the 

threat of coastal storms, lack access to resources to prepare 

for, evacuate, or cope in the event of a disaster.  Census 

data is the most readily available information to utilize in a 

vulnerability assessment.  Coastal counties and large 

communities should consider developing a social 

vulnerability index (SoVI)
33

 to determine where vulnerable 

populations live in relationship to high hazard areas.  

Because there are many socio-economic factors that 

contribute to social vulnerability, this methodology allows 

the user to choose the socio-economic parameters to 

include in the analysis.  The NJOCM piloted this 

methodology by identifying, classifying and combining 

nine Census datasets into one geospatial data layer, 

revealing the stratification of socially vulnerable areas 

relative within a three county area along the Delaware Bay.   

 

 

 

                                                 
33

 Cutter, S. L.; Mitchell, J. T.; and M. S. Scott. (2000; 1997).  

 
Hurricane Floyd, 1999 
Location: Bound Brook, NJ 

Photo credit: Andrea Booher, FEMA  

 

 
Hurricane Lili, 2002 
Location: New Iberia, LA 

Photo credit: Joe Raedle, LIFE  

 

Disabled and elderly people are 

sectors of the population may require 

evacuation assistance, safe shelter, 

medical care, and/or recovery 

assistance in the event of a coastal 

storm.    
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While the pilot was successful on the regional scale, it revealed limitations of existing Census 

data on the regional and municipal scale.  One such limitation is the varying size of Census block 

and block groups. Jurisdictions that are small in geographic size and those that are rural in nature 

will likely have limited use for Census data; thus, local facilities and zoning information may be 

more useful in identifying the location of vulnerable populations.  At this scale, municipal 

leaders and emergency managers should consider using a local registry to capture the location of 

special needs populations or utilize the existing New Jersey Register Ready Program to identify 

the individuals who may need preparedness, evacuation, or recovery assistance.  In more densely 

developed areas, Census data is limited because it does not account for the large and fluctuating 

vacation populations that visit the shore each year.  Considering that tropical storms and 

hurricanes occur during peak tourist season, 

these populations are often left out of 

vulnerability analyses.  Tourist may not be 

aware of preparedness and evacuation 

procedures or heed the warning in time.  On 

the other hand, if the shore experiences a 

nor’easter during the winter, fewer people are 

likely to be impacted.  Additionally, Census 

data may not be appropriate to use for climate 

change analyses unless population projections 

are utilized.  But, sea level rise and storm 

surge mapping can direct local governments 

where to avoid future development of 

affordable and low income housing, in 

addition to schools, soup kitchens, and 

homeless shelters.  By doing so, communities 

can proactively reduce the susceptibility of 

vulnerable populations.   

 

Social Vulnerability Considerations 
While there are limitations to Census data, it remains one of the only sources of demographic 

information to include in such an assessment.  Tabular Census data from American Factfinder 

can be joined with Census block and block group shapefiles from Tigerline to geospatially 

represent the distribution of socially vulnerable populations.  Additionally, the location of local 

facilities and zoning can be obtained from a local planning and zoning department.  

 

Census Data Considerations 

 Population Density 

 Housing Density 

 Poverty 

 Linguistically Isolated 

 Single Parent, Head of Household 

 Disabled 

 Undereducated 

 Children (17 and Under) 

 Elderly (65 and Up) 

Local Facilities and Zoning 

 Mental Care Facilities 

 Nursing Homes 

 Homeless Shelters 

 Low-Income Neighborhoods 

 Retirement Communities 

 High Density Zoning 

Map 12: Social Vulnerability along the Delaware 

Bay 
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Findings and Recommendations 
Coastal communities may not be fully aware of all of the potential impacts of coastal hazards and 

accelerated sea level rise on their infrastructure, natural resources, and vulnerable populations. 

Local vulnerability assessments can go beyond the capabilities of a county or regional all-hazard 

mitigation plan by incorporating locally significant assets, landmarks, and character defining 

features of a community.  Understanding local vulnerabilities is a critical first step in a 

community becoming more resistant to coastal hazards.   

 

During the piloting of the Coastal Community Vulnerability Assessment and Mapping Protocol 

and the Getting to Resilience questionnaire, it was evident that local and county emergency 

responders are typically the most informed about community vulnerabilities to coastal hazards.  

Yet, typically, there is a disconnect between emergency management and the long-range 

planning efforts that could minimize adverse impacts to people, development, and natural 

resources. The development of local hazard and vulnerability assessments serves as an 

opportunity to bridge this disconnect and inform coastal decision-makers from multiple 

community sectors of threats to their community’s resilience.  It also serves as an opportunity to 

engage the community in understanding hazard vulnerabilities and building the public support to 

pursue mitigation and adaptation measures.  

 

Unfortunately, many communities lack the appropriate staff to assist in the development of 

inundation and vulnerability maps. In these cases, a community should consider hiring a 

consultant or teaming up with a neighboring community to perform a shared assessment.  In 

those communities that do have GIS and planning staff, inundation mapping and vulnerability 

assessment trainings may be necessary.  Inquire with the New Jersey Office of Coastal 

Management and/or the Jacques Cousteau National Estuarine Research Reserve about 

professional training courses that address coastal hazard and climate change.  In order to 

accommodate the mapping needs of coastal communities, NOAA Coastal Services Center, the 

Jacques Cousteau National Estuarine Research Reserve and Rutgers Center for Remote Sensing 

and Spatial Analysis are developing a web resource to help communities visualize their 

vulnerabilities to sea level rise and flooding. Many of the methods that are defined in this 

document will be represented in this online tool and support local mapping efforts.  Upon 

completing a hazard and vulnerability assessment and evaluating existing local policies and 

decision-making, coastal communities will have the necessary information to begin embarking 

on hazard mitigation and climate adaptation opportunities; thus, building a resilient New Jersey 

shore.   
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Appendix A: Building a Coastal Vulnerability Index   

Technical Guidance – Mapping Protocol
The New Jersey Office of Coastal Management identified the need to go beyond inundation 

mapping to define the location of high hazard areas in coastal communities.  For the purpose of 

long-range planning and the development of municipal master plans, coastal communities should 

consider developing land suitability models, which typically identify hazard areas.  To delineate 

high hazard areas, the New Jersey Office of Coastal Management developed a composite overlay 

model of six geospatial vulnerability indicators, including geomorphology, low slopes, flood 

prone areas, storm surge inundation scenarios, poorly drained soils, and erosion prone areas.  

This type of model is a qualitative analysis that will assist in classifying a range of hazard prone 

areas, including those susceptible to chronic or episodic hazards.   
 

                   
 

This analysis requires the use of ArcGIS Spatial Analyst, along with experience using raster data 

layers and ModelBuilder.  The Coastal Vulnerability Index (CVI) can be developed using a 

Composite Rating Procedure,
34

 which involves the ranking of multiple datasets into one 

representative dataset.  The suggested model inputs include geomorphology, low-lying slopes, 

flood prone areas, storm surge inundation, soil drainage, and soil erosion. 

 

Once each input raster dataset is created and the risk ranked, the sum will be calculated using the 

Raster Calculator tool. Therefore, care must be taken to ensure that these input data sets are in 

the correct format. The following pages will provide technical guidance on building these input 

raster datasets for a region.   
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 Anderson, L. T. (1987) 

CVI = a + b + c + d + e + f 
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Getting Started  

1. Obtain the most-recent, highest resolution elevation data. Elevation data sources are listed in 

the Publically Available Data & Tools section. Take some time to examine the file in GIS as well as 

the associated metadata. The most important aspects of your data to keep in mind for the remainder of 

the analyses are:  

 Resolution (cell size) 

 Reference datums (horizontal and vertical) 

 Units (horizontal and vertical) 

It will be important to write these down because every new layer of the analysis should share these 

same parameters. 

  

2. Clip DEM to study area. DEM data files are very large. Since larger files increase the processing 

time, it is helpful to define your study area and then clip the DEM to this area. It will save time in the 

future. 
 

Spatial analyst tools > Extraction Tools > Extract by mask 

 

3. Hydroflatten DEM. LiDAR data 

is wonderful for land elevation; 

however, the devices are not 

capable of penetrating water. 

Therefore, data over water are 

unreliable and often meaningless. 

It is best to deal with this by 

creating a “hyroflattened” DEM 

file by changing all values that 

occur over water to zero within 

cells of your DEM. To accomplish 

this, you will need a GIS polygon 

of the water in your region.  

a. Obtain water shapefile. 

Examine it to make sure it 

represents actual coastal 

boundaries (i.e. wetlands 

or other low-lying areas 

are not cut off).  

b. Add field within attribute table. Name it WL and give all rows a value of “0” 

c. Convert water feature to raster 

 

Conversion Tools > To Raster > Feature to Raster 
 

Make sure FIELD is set as “WL” – The result will be a raster file representing water areas with 

a value of zero at all cells. 
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d. Create mosaic raster combining DEM and water rasters.  

 

Data Management Tools > Raster > Raster dataset > Mosaic to New Raster 
 

Be sure that the output raster has the same cell size as the DEM  

4. Use this hydroflattened DEM for all future analyses. 
5. Create a MHHW raster. In this step you will give V-Datum a data set that you create for MHHW 

and have it convert it to NAVD88 (the vertical datum of your DEM). If the input dataset is 

intentionally set to zero, V-Datum will output the distance above or below NAVD88 that the real 

MHHW reference lays. To do this, create a new raster over your study area with a constant value of 

Zero. Set the cell size to at least 250 (this is probably enough to get capture the MHHW variability in 

the region; the raster will later be scaled to the same cell size as the DEM). 

 

Spatial analyst tools > Raster Creation > Create Constant Raster 

Value = 0 

Output extent = same as study area 

 

6. Convert Raster to points. Since V-Datum only uses point data, we need to convert to points.  

 

Conversion Tools > From Raster > Raster to Point 

 

7. Assign coordinates to the points. V-datum needs to be able to match the coordinates of your study 

area with those of the basins loaded into its databases. It can be difficult to be sure of the coordinate 

system of your raster is recognized similarly by V-Datum (this is especially true if your DEM uses 

one of the State Plane coordinate systems). Luckily with just a couple extra steps, you can save some 

confusion and be sure that V-Datum is calculating correctly.  

a. Be sure that your projection is the same as is assigned to your DEM 

b. Open Attribute Table and add 2 new fields 

c. Populate each with X or Y coordinates  

 

Calculate Geometry > Add X coordinates > Units: decimal degree 

 

d. Close Attribute Table 

e. Add XY coordinates (using the same coordinate system as your map) 

 

Data Management Tools > Features > Add XY Coordinates 

 

8. Open Attribute Table. Now your dataset has coordinates assigned to each point that both V-Datum 

and ArcMap will understand 

9. Export Table as dbase file (.dbf). The exported table will need to be “cleaned up” for V-Datum to 

recognize the data. This can be easily done in Excel. 

10. Clean up using Excel  

a. Open the dbase file in Excel. V-Datum only reads numbers in a particular order. The finished 

table should be in the following format: 

 

FID | LONG | LAT | OBJECT_ID 
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Once the columns are arranged in this way, delete the extras and the top row (labels) 

b. Save file as .csv and Close Excel. 

11. Convert to NAVD88 using V-Datum  

a. Open V-Datum. Make sure your study area is listed in the dropdown menu. If not, you may 

need to download it.  

*note* V-datum basins are updated periodically; therefore it’s a good idea to make sure your basin 

data is current. When in doubt, download a new version.  

b. Horizontal datum should match your study area (probably NAD83) 

c. Vertical input is 

MHHW 

d. Vertical Output is 

NAVD88 

e. Make sure the 

height units match 

your DEM 

f. Coordinate System 

is Lat, Long 

g. Under “file 

conversion” make 

sure “long, lat” is 

selected (this is the 

order that columns 

are in your data 

file). 

h. Find your .csv file as your input 

i. Convert. You now need to “clean up” the output for GIS 

12. Clean up in Excel 

a. Open a new blank document in Excel 

b. Import from text and find new .csv file 

c. Add top row and labels (as below).  

 

ID | LONG | LAT | MHHWinNAVD88 

 
d. Also open your pre-VDatum dbase file 

e. Copy the entire columns named POINT_X and POINT_Y 

f. Paste them in the new .xlsx file. Your new data now reference the coordinate system of your 

map.  

g. Examine your data. The MHHWinNAVD88 column should have many cells with -99999 as 

the value. This represents points where there was no V-Datum conversion. Make sure all 

values do not appear as -99999. If so, the coordinates were likely wrong.  

h. Save as new .xlsx file and close Excel 

13. Import new table into ArcMap 
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14. Plot data on map. In the table of contents, right click on new file and select Display XY Data 

 

X field = X_POINT 

Y field = Y_POINT 

Z Field = <none> (assigned later) 
 

The new plotted points will appear as “Sheet1events.” Export this to new file to make it permanent. 

15. Examine your file. Zoom to layer. Your points should be displayed in the same place as the pre-

VDatum points. If, not the coordinates are probably wrong.  

16. Convert points to raster 

 

Conversion Tools > To Raster > Point to Raster 

Value = MHHWinNAVD88 

Cell Assignment = Maximum 

Priority Field = NONE 

Cell Size = [whatever was used before] 

 

17. Extrapolate Upstream. V-Datum does not give values up into tidal creeks and small rivers. As these 

are still areas of flood concern, we need a way to extrapolate our values up into the creeks. There are 

several steps involved in this transformation because the particular tool used uses only integer values 

and the V-Datum outputs have decimals. To allow for the use of this tool, but also preserve the 

accuracy of our water heights, we need to incorporate several steps. It may be best to use 

ModelBuilder for this step. The model below is taken from the NOAA Coastal Services Center’s 

Coastal Inundation Mapping 

Guidebook (2012). Tools for each step 

can be found in the Spatial Analyst 

Tools. 

a. Multiply the Raster by 1000. This 

preserves the accuracy of the points 

in integer form. 

b. Convert this value to an integer. 

ArcMap has to view this number as 

an integer, which requires a small 

conversion. 

c. Convert unknown values to 

“NoData.” Remember that V-Datum 

uses a value of -99999 for all 

unknown values. This tool will not 

read that as such, so it should be 

converted to “NoData.” 

d. Run the Euclidian Allocation tool. 

e. Spatial Analyst Tools > Distance > Euclidian Allocation  

f. Convert Output back to Floating Point. This step is to get back to a decimal form 

g. Divide by 1000. This puts the accuracy back to its original form. 
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h. Save this file. Many of the outputs from Spatial Analyst are temporary, so it is important to make 

them permanent. Name this file EA_MHHW.  

18. Subtract the DEM from this Raster. The raster just created represents the distance to MHHW from 

NAVD88. To get inundation at MHHW, the DEM needs to be subtracted. Use the following 

conditional statement in Raster Calculator: 

 

Con(MHHW>=DEM, MHHW-DEM) 

 

Scale back to cell size of the DEM. While in Raster Calculator, click on the Environments button. 

Under Spatial Extent, select “Same as DEM.” 

19. Display this Raster as MHHW inundation. Save this raster. 
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Slope   

The terrain of a coastal region can greatly impact its vulnerability to periodic flooding and sea 

level rise.  Utilizing available LiDAR, land areas below 2 percent slope were identified as 

vulnerable.  As slope decreases, more land areas become prone to pooling of water, allowing for 

prolonged coastal flooding.  Theoretically, the Brunn Rule indicates that every foot rise in water 

will result in a 100 foot loss of sandy beach, whether it is an episodic storm event or permanent 

inundation due to sea level rise.  In other words, a 1 percent slope or less is likely to be inundated 

with a 1 foot rise in water.  While the Brunn Rule does not apply to all land types, it provides 

insight that low-lying coastal areas are most vulnerable to inundation and changing coastal 

conditions.     
1. Get Slope Values from DEM.  

 

Spatial Analyst Tools > Surface > Slope 

Add layer: DEM (hydroflattened) 

 

*Note*: Slope should be assessed as “percent rise.” z-correction option should be used if the DEM 

used different units for x & y than it does for z (e.g. meters for x & y, but elevations in ft) 

2. Rank and reclassify as below. 

 

Spatial Analyst Tools > Reclass > Reclassify 

 

*Note*: The upper limit of the ranking should be the upper limit of your slope raster.  

 

Slope (%) Rank GIS Rank 

> 2.00 None 0 

1.00 - 2.00 Very Low 1 

.75 – 1.00 Low 2 

.50 - .75 Moderate 3 

.25 - .50 High 4 

< .25 Very High 5 
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Flood Prone Areas 

FEMA’s Flood Insurance Rate Maps (FIRM) are the most accessible digital flood information 

available to municipal officials. While FEMA is in the process of generating updated flood maps 

for coastal New Jersey, communities can supplement their knowledge by using existing soils 

data to identify flood prone lands.  Utilize DFIRM Q3 Maps were used as the basis for the 

analysis and rank the attributes according to level of risk.  The V-Zone should be ranked as the 

most risk prone, while the 100-Year Floodplain and the 500-Year Floodplain should be identified 

as high to moderately risk prone.  Where shorelines have shifted and lands have accreted since 

the Q3 maps were developed, utilize the ranking of the floodzone adjacent to it, typically a V-

Zone or A-Zone.  For the land areas that are outside of designated floodzones, utilize soils data 

(SSURGO, flodfreqmax) to identify soils that have a high to occasional likelihood of flooding in 

a given year.: 

 

Necessary Data and Sources:     

Data Source 

Flood Hazard Areas FEMA DFIRMS 

Flood Prone Soils USDA: Soils Data Mart; New Jersey SSURGO (with tabular files: 

mapunit and muggatt; found at: 

http://soildatamart.nrcs.usda.gov/templates.aspx) 

 
1. Import FEMA Flood Hazard Areas (DFIRM). Clip map to study area. 

2. Examine Feature. Open Attribute Table and examine fields FLD_ZONE & LEGEND 

Notice  

0.2 PCT ANNUAL CHANCE FLOOD HAZARD = 500 Year Flood Zone 

A & AE = 100 Year Flood Zone 

V & VE = 100 Year Flood Zone* 

*V & VE represent velocity zones, higher vulnerability 

3. Import SSURGO layer 

4. Add Tabular Soil Data.  Tabular soils data is available for download at the link above. The 

download contains an MS Access Database. Individual tables can be added to ArcCatalog by 

exporting from Access to .xls files. 

a. From ArcCatalog, add “mapunit” & “muggatt” 

b. Right click on SSURGO layer and join mapunit. They share the field “mukey” in 

common.  

c. Then join muggatt 

5. Create Feature of Flood Prone Soils  

a. Open joined attribute table 

b. Examine field: flodfreqmax 

c. Select by attributes (flodfreqmax = frequent, very frequent, and occasional) 

d. Export Selected areas to new layer 

6. Delete area outside already covered by FEMA maps 

Analysis Tools > Overlay > Erase 

7. Merge Frequently Flooded Soils to FEMA Zones 

Data Management Tools > General > Merge 

http://soildatamart.nrcs.usda.gov/templates.aspx


 

 

 
42 

8. Expand new feature to cover entire study area. Because all indices will be added together 

eventually, it is important to have cells present in areas where data does not exist.  

a. Erase Flood areas from study area feature. 

Analysis Tools > Overlay > Erase 

b. Add field to non-flood prone areas feature 

c. Name the new Field “Index” and value at “0” 

 

9. Create Flood Prone Index 

a. Merge non-flood with flood zones 

b. Turn Edit On 

c. Rank in Index Field (as below) 

Flood Prone Areas Rank GIS Rank 

Outside of Floodplain and non-flood prone soils None 0 

Occasionally Flooded Soils Outside of the Floodzone Very Low 1 

Frequently Flooded Soils Outside of the Floodzone Low 2 

500-Year Floodplain (X500) Moderate 3 

100-Year Floodplain (A, AE) High 4 

Velocity Zones (V & VE) Very High 5 

 
10. Convert to Raster 

Conversion Tools > To Raster > Feature to Raster 

Field = Index 

Output cell size = [same as DEM] 
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Drainage 

Soil drainage influences the period of time coastal lands are inundated after a storm event. While 

highly drained soils typically consist of sands and porous sediments, poorly drained soils are 

typically wetland soils or clays.  Using soil data from USDA NCRS (SSURGO, drclassdcd), 

rank soils from well drained to very poorly drained.   ‘Somewhat excessively drained’ and 

‘excessively drained’ soils should not be considered in this analysis because they are not 

vulnerable to extended inundation.  While well drained soils can decrease vulnerability, be aware 

that there may be an inverse relationship with erodible soils because well drained soils are 

typically associated with sand.   
 

Necessary Data and Sources:     

Data Source 

Soil Drainage Class USDA: Soils Data Mart; New Jersey SSURGO (with tabular 

files: mapunit and muaggatt; found at: 

http://soildatamart.nrcs.usda.gov/templates.aspx) 

 
1. Import SSURGO layer 

2. Add Tabular Soil Data  

a. From ArcCatalog, add “mapunit” & “muaggatt” 

b. Right click on SSURGO layer and join mapunit. They share the field “mukey” in common.  

c. Then join muaggatt (sharing “mukey”). 

3. Create Drainage Index 

a. Add Index Field to Attribute Table and sort by drainage class  (“drclassdcd”) 

b. Turn Editor On and rank drainage classes as below 

4. Convert to Raster 

Conversion Tools > To Raster > Feature to Raster 

Value: index 

 

Soil Drainage Rank GIS Rank 

Excessively Well Drained None 0 

Well Drained Very Low 1 

Moderately Well Drained Low 2 

Somewhat Poorly Drained Moderate 3 

Poorly Drained  High 4 

Very Poorly Drained Very High 5 

http://soildatamart.nrcs.usda.gov/templates.aspx
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Erosion 

There are multiple ways to assess erosion risk.  Communities should use erosion data that are 

available to them, which many require erosion rates of coastlines to be projected into the future 

to fully assess erosion risk.  Because erosion analysis has not been done for all shorelines and 

shoreline types in New Jersey, communities can utilize existing datasets available to them, 

including erodible soils data (SSURGO, kffact) and historical shoreline data. The soils data 

should serve as the basis of the erosion model.  Rank the kffact scores, which represent the 

susceptibility of soil particles to detachment by water.  Note that there are gaps in the data. 

Where there is an obvious correlation between adjacent soils, utilize the adjacent classification.  

Where there is not an obvious correlation, rank the area as 0.  To supplement the soils data, 

utilize historic shoreline data to identify beachfront areas that have a history of erosion or 

accretion.  Areas of historic erosion should be classified as very high. Areas of historic accretion 

should be classified as 5 because those land areas are susceptible to change.      

Necessary Data and Sources:     

Data Source 

Soil Erodability USDA: Soils Data Mart; New Jersey SSURGO (with tabular files: 

mapunit, component, and chorizon; found at: 

http://soildatamart.nrcs.usda.gov/templates.aspx) 

Historical Erosion Any existing data sets that display areas of historic erosion 

 
1. Import SSURGO layer 

2. Add Tabular Soil Data  

a. From ArcCatalog, add “mapunit,” “component,” and “chorizon” 

b. Right click on SSURGO layer and join mapunit. They share the field “mukey” in common.  

c. Right click on component and join chorizon. They share the field “cokey” in common. 

d. Join component:chorizon to the SSURGO layer using common field, “mukey.” 

3. Add historic erosion/accretion data 

a. If the data exists for your study area,  add data layers 

b. Merge to SSURGO data as explained in Flood-Prone Section 

4. Create Erosion Index 

a. Add Index Field to Attribute Table and sort by “Kffact” 

b. Turn Editor On and rank as below 

5. Convert to Raster 

Conversion Tools > To Raster > Feature to Raster 

Value: index 

 

Erosion Prone Areas Rank GIS Rank 

No Kffact Attribute None 0 

.10 Kffact Very Low 1 

.17 and .15 Kffact Low 2 

.28 and .20 Kffact Moderate 3 

.37 and .32 Kffact, Historic Accretion High 4 

.43 Kffact, Historic Erosion Very High 5 

http://soildatamart.nrcs.usda.gov/templates.aspx
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Geomorphology   

The New Jersey shore is comprised of multiple geomorphic settings because of varying wave, 

current, and wind energy that exists along the coast.  There are seven distinctive shoreline types 

along the Jersey shore, including spits, high and mixed-energy barrier island systems, headlands, 

bays and open bay systems, tidally influenced, freshwater rivers and estuaries.  These shoreline 

types are indicative of the natural hazards and geologic processes that have shaped them over 

time. Geomorphology should be included in large-scale assessments, but may not be necessary in 

coastal communities because they typically represent one geomorphic region.  The NJCMO 

delineated multiple geomorphic classifications along the New Jersey shore by identifying the 

watersheds that are tidally influenced and labeling them with the geomorphic description 

identified in the New Jersey Shore Protection Master Plan.  Based on anecdotal information, 

each geomorphic region was ranked for its vulnerability to coastal hazards and sea level rise.   

Necessary Data and Sources:     

Data Source 

Geomorphic Region 

NJDEP-GIS: Tide Gauges and Watershed; NJCMP- Shore 

Protection Master Plan 

 
1. Import Geomorphology Layer. There is no “standard” geomorphology layer. Keep in mind that 

your study area may not have all geomorphic regions below represented. If you do not have a 

geomorphic region layer, you can classify a watersheds layer by geomorphic region using editor as 

below. 

2. Create Geomorphology Index 

a. Add Index Field to Attribute Table and sort by region 

b. Turn Editor On and rank as below. 

3. Convert to Raster 

 

Conversion Tools > To Raster > Feature to Raster 

Value: index 

 

Geomorphic Region Rank GIS Data 

Non-Tidally Influenced Watersheds None 0 

Headland Systems Very Low 1 

Freshwater Tidal Systems Low 2 

Back Bays and Open Bay Systems Moderate 3 

Mixed-Energy Barrier Systems High 4 

Spits & High-Energy Barrier Systems Very High 5 
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Storm Surge 

Storm surge inundation patterns are not usually well represented in flood plain maps. To 

understand the potential for inundation, communities should apply the National Hurricane 

Center’s SLOSH Model, coupled with a MHHW scenario, to understand the worst case scenario 

of any storm event. MHHW represents the daily extent of tidal inundation and is obviously the 

most vulnerable area. The inundation of a category one storm would be classified as the high, 

followed by the inundation extent of a category two hurricane, etc.  These storm scenarios are 

ranked this way because a category one storm is most likely to occur.  Additionally, if a category 

four storm impacted the Shore, the inundation will be worst in low-lying areas.   

 
To create the Storm surge index, we must create inundation maps for each category storm and 

then combine them. Below are instructions for doing this using the SLOSH viewer and ArcGIS.  

 

Necessary Data and Sources:     

Data Source 

Historic Storm Tracks NOAA National Hurricane Center 

Modeled Storms (MOM’s) SLOSH Model, VDatum 

Elevation Data (LiDAR) USGS Click 
21. Export SLOSH Outputs. As mentioned in section (X), The MOM projections should be used in this 

analysis. SLOSH display basin are currently being updated to display surge with respect to NAVD88, 

however, some are still in NGVD29, so check the datum of reference listed on the legend when the 

storm is loaded. 

a. Open SLOSH Display 

b. Choose your basin of interest 
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c. Select Storm. Choose MOM; use “HI” for each category to display worst case 

d. Save data 

 

File > save data to .shp 

 
e. Repeat for each category storm 

22. Import SLOSH Outputs. Examine this file. Make sure the projection of the SLOSH data matches 

the DEM. The surge values represent inundation relative to NAVD88. If they are not, V-Datum can 

transpose them not NAVD88 (This will be addressed in step 4 below). Some steps need to be taken to 

display as inundation over land for your region.  

23. Delete areas without surge values. Open attribute table. Notice the value of “99.9” in many of the 

surge height rows. This represents areas where surge would not reach. This should be deleted. 

a. Select (by attributes) and delete from feature. 

24. Plot the centroids of surge data. The SLOSH outputs features give surge values across a wide swath 

of surge zone. As a result, the resolution can be quite coarse in some areas. Therefore, we need to 

interpolate this data on a smaller scale. To start this process, we must plot the centroids of the surge 

data.  

a. Add fields for x and y in attribute table 

b. Populate them accordingly using “Calculate Geometry.” 

c. Check the vertical units of your DEM. The SLOSH outputs are in feet. If your DEM uses 

metric units, you will need to add a new field to convert the output to meters. 

d. Export Table as dbase file (.dbf). Add table to current map. 

e. Right click on SLOSH table layer and go to “Display X Y Data” using new fields as X &Y. 

The Z field should be your surge height (with correct units). 

f. Export new “Events” layer as new feature to make permanent 

25. Interpolate SLOSH centroids. There are numerous interpolation methods available on ArcGIS, but 

we’ll use Spline Tool. Chose surge heights (with correct units) for the value field. Be sure that your 

output cell size is the same as your DEM 

 

Spatial Analyst Tools > Interpolation > Spline 

 

26. Subtract your DEM from the interpolated surge raster. Because the surge heights are referenced 

to NAVD88, they do not represent inundation over land until the actual heights of the land surface 

(with respect to NAVD88) are subtracted. To accomplish this, we create a conditional statement in 

Raster Calculator. 

 

Spatial Analyst Toots > Map Algebra > Raster Calculator 

Equation: Con(SURGEHGT>=DEM, SURGEHGT-DEM) 

 

This states, “In all conditions in which the surge height is greater than the DEM (i.e. where 

inundation occurs); subtract the DEM from the surge height.” 

27. Repeat steps 2 – 6 for all categories of storm.  

28. Add MHHW raster created in Section 1 

29. Create Storm Surge Index 

a. Reclassify rasters. Change “NoData” to “0.” Change all other values to “1.”  

b. Use the Combine Tool to add all Storm Surge rasters and the MHHW raster.  
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c. Examine output raster. Add Index Field to attribute table. Add all raster columns in combined 

raster 

 
d. Assign ranking based on index values.  
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Hurricane Storm Surge  Rank GIS Rank 

Areas Outside of Surge None 0 

Category 4 Very Low 1 

Category 3 Low 2 

Category 2 Moderate 3 

Category 1 High 4 

Mean Higher High Water Very High 5 
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Putting It All Together – Coastal Vulnerability Index 

 
 

To classify each input, add a column to each feature or raster layer and add the corresponding 

rankings associated with the degree of vulnerability, as seen in the table on the following page 

and in the model input descriptions seen later in this appendix.  Once all original inputs are 

ranked, ensure that it is in or is converted to a raster data layer, based off of the column of the 

vulnerability ranking. The cell size of each raster should correspond to the resolution of the 

LiDAR DEM being used in the analysis. Ensure that the rankings in the attribute table of each 

raster data layer still corresponds with the correct vulnerability rankings.  If they do not, 

reclassify each input into the correct vulnerability ranking scheme.  Next, combine each of the 

raster layers into one raster data set, using the Combine Tool or Weighted Sum Tool.  Once the 

inputs are combined into one output model, the separate rankings from each input should be 

visible.  Add a column.  Within that column, sum the rankings from each input.   

 
 

1 4 3 
 

4 2 
No 

Data 

 
5 6 3 

4 6 2 + 3 5 2 = 7 11 4 

No 

Data 
3 5 

 
1 4 5 

 
1 7 10 

 

Note that spatial data does not always align with one another; therefore, unranked data and NO 

DATA values should equal 0.   This will avoid deleting land areas where the datasets do not 

fedcbaCVI

Where   

a =  Geomorphology 

b = Slope 

c = Flood Prone Areas 

d = Storm Surge Inundation (SLOSH)  

e = Soil Drainage 

f = Soil Erosion  
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perfectly align, especially along shorelines.  After totaling the rankings, any areas that have a 

value of 0 can be deleted from the analysis.  This will include coastal waters and may include 

upland areas that are not vulnerable to hazards. 
1. Create Coastal Vulnerability Index 

a. Reclassify rasters. Change “NoData” to “0.” All other values (1-5) should remain the same.  

b. Use the Combine Tool to add all rasters.  

 
 

c. Examine output raster. Add Index Field to attribute table. Add all raster columns in combined 

raster 

d. Assign ranking based on index values.  

Table 1: Coastal Vulnerability Index: Ranking by Variable 

Variable Very Low Low Moderate High Very High 
(a) Geomorphology Headland 

Systems 

Freshwater 

Tidal Systems 

Back Bay and 

Open Bay 

Systems 

Mixed-Energy 

Barrier Systems 

Spits and High 

Energy Barrier 

Systems 

(b) Slope (%) 1.00 – 2.00 .75 – 1.00 .50 - .75 .25 - .50 <.25 

(c) Flood Prone Moderately 

Flood Prone 

Soils Outside of 

the Floodplain 

Highly Flood 

Prone Soils 

Outside of 

Floodplain 

500-Year 

Floodplain 

100-Year 

Floodplain 

Velocity Zone 

(d) Storm Surge 

(SLOSH) 

Category 4 

Hurricane 

Category 3 

Hurricane 

Category 2 

Hurricane 

Category 1 

Hurricane 

Mean High 

Higher Water 

(e) Drainage Well Drained  Moderately 

Well Drained  

Somewhat 

Poorly Drained 

Poorly Drained Very Poorly 

Drained 

(f) Erosion .10 Kffact .17 & .15 

Kffact 

.28 & .20 

Kffact 

Historical 

Accretion and 

.37 & .32 

Kffact 

Historical 

Erosion and    

.43 Kffact 

Ranking 2 3 4 5 6 
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Sea-Level Rise 

Because there are numerous sea level rise projections, the NJOCM suggests that communities 

utilize a 0.5, 1.0, and/or 1.5 meter scenario when modeling sea level rise. There are multiple 

ways that a community can visualize the potential inundation threats associated with sea level 

rise.  A Bath Tub Model is a simple model that utilizes a digital elevation model to determine 

land areas that lie below a particular elevation contour. To create such a model, one can either 

convert a LiDAR DEM from NAVD88 to a MHHW tidal datum prior to performing the 

inundation analysis or create a ‘generic’ MHHW zero raster and convert this to NAVD88 using 

V-Datum. If you have already run the CVI, you can use the MHHW raster you created in the 

Getting Started section. Sea level rise models can also be applied on top of spring tide scenarios 

to reflect the inundation extent of future spring tides. 

 
1. Add Sea-level rise projections. Since we have a raster for MHHW, we can add levels of see-level 

rise to this file using the Math tools. Be sure that the SLR value is added to the EA_MHHW file. Also 

be sure that the additions are in the correct units (i.e. 1ft or 1m, depending on the vertical units of 

your DEM) 

Spatial Analyst > Math > Plus 

Input raster or constant value 1: EA_MHHW (not the inundation file) 
Input raster or constant value 2: [value of SLR] 

 

2. Subtract the DEM from this Raster. Follow the equation shown in step 14 above. 

3. Repeat for additional SLR values. We recommend either 0.5 m intervals or 1 ft intervals. 
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Interaction between Sea-Level Rise and Storm Surge 

 

So far, this cookbook has explained how to express inundation due to Sea-level Rise and due to 

Storm Surge separately. It can be useful to visualize impacted areas from each of these hazards 

on their own. However, these hazards are inherently linked. For example, if a region experiences 

3 ft of SLR, a Category 1 hurricane will inundate much more area than it would have at current 

MHHW. Therefore, a simple “overlay” of the two layers does not account for the interaction 

between the two.  

 

To account for sea level rise, storm surges can be geographically reflected with 0.5, 1.0, or 1.5 

meters of additional rise and ranked with the same classification scheme as existing surge 

models. Since the SLOSH outputs are referenced to NAVD88, simply adding the projected rise 

in SLR to the output before subtracting the DEM will provide a rough idea of how SLR will 

affect storm surge in the future. This step should occur after the surge points are interpolated. 

 
1. Interpolate SLOSH centroids. (Step 5 above). Be sure that your output cell size is the same as your 

DEM 

Spatial Analyst Tools > Interpolation > Spline 

 
2. Add Sea-level rise projections. Since we have a raster for MHHW, we can add levels of see-level 

rise to this file using the Math tools. Be sure that the SLR value is added to the EA_MHHW file. Also 

be sure that the additions are in the correct units (i.e. 1ft or 1m, depending on the vertical units of 

your DEM 

Spatial Analyst > Math > Plus 
Input raster or constant value 1: [interpolated surge raster] 

Input raster or constant value 2: [value of SLR] 

 
3. Subtract the DEM from this Raster. Use the following formula in Raster Calculator 

 

Con(SURGEwSLR>=DEM, SURGEwSLR-DEM) 

 
Be sure to Scale back to the cell size of the DEM if the surge layer was coarser than the DEM 

4. Repeat for additional Surge values. There are up to 20 combinations of SLR and Storm Surge that 

can be mapped. It will be up to the mapper to decide which projections to include.  
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Appendix B: Delaware Bay Focus Area 

 

The Delaware Bay is designated as a region of 

particular importance by the New Jersey 

Office of Coastal Management because it 

remains relatively undeveloped compared to 

the Atlantic coast.  The Bay serves as the 

terminating point of the vast Delaware River 

Basin drainage and is part of the nationally 

designated Delaware Bay Estuary which 

encompasses nearly 650 square miles of 

wetlands.  Its rural landscape is comprised 

mainly of tidal wetlands, farmland and a 

handful of narrow, developed beaches.  

Historically, the Bay was once home to 

multiple ports and fishing villages, but large 

scale operations altered this scenario.  The 

maritime industry is now located further up 

the Delaware River near Camden and 

Philadelphia. While the Delaware Bay 

remains relatively undeveloped, it has been altered by human use.  Despite the fact that the Bay 

as a whole has lost fifty percent of its tidal wetlands, it still supports the majority of the New 

Jersey’s tidal wetlands and is rich in its biodiversity.  The Bay serves as the largest spawning 

ground for horseshoe crabs in the world, and is the second largest avian staging area for 

migratory shorebirds in the Western Hemisphere.  In addition, Salem, Cumberland, and Cape 

May counties alone provide an estimated $2.25 - $3.17 billion annually in ecosystem services, 

mainly due to filtration and habitat that the immense acreage of tidal wetlands provide within 

this region.
35

  Unfortunately, high rates of erosion have resulted in a loss of tidal marshes and 

beachfront, threatening habitat, ecosystem services and historic resources alike.  As sea level rise 

accelerates, it is anticipated that erosion rates, saltwater intrusion and inundation from storms 

will increase as well, exacerbating the loss of critical habitat and natural storm buffers.   

 

Recognizing the Delaware Bayshore’s abundant natural resources and that bay communities are 

threatened by the impacts of coastal hazards, the New Jersey Office of Coastal Management 

identified it as a pilot study location to develop and test the Coastal Community Vulnerability 

Assessment and Mapping Protocol.  In 2007 and 2008, high resolution elevation data (LiDAR) 

was collected for this area.
36

  Data was collected within ± 3 hours of Mean Low Water, capturing 

the intertidal zone, which will allow for more precise delineation of vulnerable areas along the 

Bay.  High quality elevation is the single most important dataset in a vulnerability assessment. It 

allowed the NJOCM to assess the vulnerability of the Delaware Bay to the impacts of coastal 

hazards and sea level rise, as seen throughout this document.   

                                                 
35

 NJDEP. (2007). 
36

 See page 12 for more information on LiDAR. 

Map 13: Delaware Bay Coastal Counties – LiDAR  
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Appendix C: Pilot Assessments 
The New Jersey shore is geographically diverse, varying in geologic and demographic 

composition.  New Jersey’s northern shores are located within the New York-New Jersey 

Metropolitan area, one of the most highly urbanized and industrialized regions in the nation, 

while the shores of the Delaware Bay are sparsely populated and largely consist of tidal wetlands 

and agricultural lands.  Because the character of coastal communities varies throughout the state, 

the NJOCM recognized the need to pilot the Coastal Community Vulnerability Assessment and 

Mapping Protocol and the Getting to Resilience questionnaire in coastal communities with 

varying geographic and demographic characteristics. 

 

The Coastal Community Vulnerability 

Assessment and Mapping Protocol and 

resilience assessment tools were piloted 

in Cape May Point, Little Silver, and 

Oceanport.
37

  The NJOCM was also able 

to pilot its assessment tools in Greenwich 

Township, which is located in 

Cumberland County along the Delaware 

Bay.
38

  The pilot communities 

represented small to medium sized 

communities located along back-bays, 

beachfronts, and tidal creeks, but did not 

include Atlantic beachfront communities 

or large, intensely developed 

municipalities.  Prior to these research 

efforts, none of the participating 

communities had locally generated 

vulnerability assessments.  The 

communities had relied upon consultants 

to generate their existing municipal 

master plans and were dependent upon 

their county governments to incorporate 

them into countywide or regional all-

hazard mitigation plans.  In piloting the 

vulnerability mapping and resilience questionnaire, the NJOCM and coastal partners convened 

meetings with a diverse group of local decision-makers.  While participation varied by 

municipality, the participating community leaders were eager to learn about their community’s 

existing and future coastal hazard vulnerabilities and resilience capacity.  Through the 

commitment of these community leaders, the NJOCM was able to validate and improve upon its 

assessment tools for their future application along the New Jersey shore. 

                                                 
37

 New Jersey Sea Grant Consortium. (2010). 
38

 NJDEP. NJOCM. (2011a).  

   Map 14: Pilot Communities 



 

 

 

61 

Works Cited 
Anderson, L. T. (1987). Seven Methods for Calculating Land Capability/Suitability.  Planning Advisory  

 Service Report 402. American Planning Association, Chicago. 

 

Bush, D. M., Neal, W. J., Young, R. S. and O. H. Pilkey. (1999). “Utilization of Geoindicators for Rapid  

Assessment of Coastal-Hazard Risk and Mitigation.”  Ocean & Coastal Management. 42: 647-

670 

 

Clough, J. (2010). Sea Level Affecting Marshes Model, 6.0.1 Beta. Warren Pinnacle Consulting.  

 http://warrenpinnacle.com/prof/SLAMM/  

 

Cooper, M. J.P., Beevers, M. D., and M. Oppenheimer. (2005). Future Sea Level Rise and the New Jersey  

Coast: Assessing Potential Impacts and Opportunities. Woodrow Wilson School of Public and 

International Affairs, Princeton University, Princeton, NJ 

 

Cutter, S.L. (2008). “A Framework for Measuring Coastal Hazard Resilience in New Jersey  

Communities.” White Paper for the Urban Coast Institute at Monmouth University. Prepared by 

S.L. Cutter with the Hazard & Vulnerability Research Institute at the University of South 

Carolina.  

 

Cutter, S.L.; Mitchell, J.T.; and M.S. Scott.  (2000). “Revealing the Vulnerability of People and Places: A  

Case Study of Georgetown County, SC.” Annals of the Association of American Geographers, 

90(4). 713-737 

 

……… (1997). “Handbook for Conducting a GIS-Based Hazards Assessment at the  

County Level.” Hazards Research Lab, Department of Geography, University of South Carolina. 

 

Federal Emergency Management Agency (FEMA). (2011). Federal Insurance and Mitigation  

 Administration. http://www.fema.gov/about/divisions/mitigation.shtm  

 

………(2007). National Flood Insurance Program. Community Rating System (CRS) Coordinator’s  

 Manual.   

http://training.fema.gov/EMIWeb/CRS/2007%20CRS%20Coord%20Manual%20Entire.pdf 

 

Gornitz, V. M., Daniels, R. C., White, T. W., and Birdwell, K. R. (1994). “The Development of a Coastal  

Risk Assessment Database: Vulnerability to Sea-level Rise in the U.S. Southeast.” Journal of 

Coastal Research, Special Issue No. 12, p. 327-338. 

 

Hammar-Klose, E. S. and R. E. Thieler. (2001). “Coastal Vulnerability to Sea-Level Rise: A Preliminary  

Datbase for the U.S. Atlantic, Pacific, and Gulf of Mexico Coasts.”  U.S. Department of the 

Interior: U.S. Geological Survey. Woods Hole, MA. http://pubs.usgs.gov/dds/dds68  

 

Hayes, B.D. (2004) “Interdisciplinary Planning of Nonstructural Flood Hazard Mitigation.”  Journal of  

 Water Resources Planning and Management. 130(1): 15-25 

 

Hazards & Vulnerability Research Institute. (2011). The Spatial Hazard Events and Losses Database for  

the United States, Version 9.0 [Online Database]. Columbia, SC: University of South Carolina. 

http://www.sheldus.org  

 

http://warrenpinnacle.com/prof/SLAMM/
http://www.fema.gov/about/divisions/mitigation.shtm
http://training.fema.gov/EMIWeb/CRS/2007%20CRS%20Coord%20Manual%20Entire.pdf
http://pubs.usgs.gov/dds/dds68
http://www.sheldus.org/


 

 

 

62 

……...(2008). “The SoVI Recipe.” Columbia, SC: University of South Carolina.  

http://webra.cas.sc.edu/hvri/docs/SoVIRecipe.pdf  

 

Industrial Economics. (2010). “Application of Ecological and Economic Models of the Impacts of Sea- 

Level Rise to the Delaware Estuary.” Prepared for the EPA and the Partnership for the Delaware 

Estuary. http://www.delawareestuary.org/pdf/Climate/IEc-

%20Delaware%20Estuary%20SLAMM%20HEA%20-%20June%202010.pdf  

 

Intergovernmental Panel on Climate Change (IPCC). (2007).Climate Change 2007: Impacts, Adaptation  

and Vulnerability. Contribution of Working Group II to the Fourth Assessment Report of the 

Intergovernmental Panel on Climate Change, M.L. Parry, O.F. Canziani, J.P. Palutikof, P.J. van 

der Linden and C.E. Hanson, Eds., Cambridge University Press, Cambridge, UK, 976pp. 

 

Lathrop, R. G. and A. Love. (2007). “Vulnerability of New Jersey’s Coastal Habitats to Sea Level Rise.”  

Grant F. Walton Center for Remote Sensing and Spatial Analysis, Rutgers University, New 

Brunswick, NJ in partnership with the American Littoral Society, Highlands, NJ. 

 

Lennon et al. (1996). Living with the South Carolina Coast. Program for the Study ofDeveloped  

 Shorelines (PSDS). Duke University Press.  

 

Mileti, D. (1999). Disasters By Design: A Reassessment of Natural Hazards in the United States.  

 Washington, DC: Joseph Henry Press. 

 

Miller, K., Sugarman, P.J., and J.V. Browning. (2011). “Sea-Level and Climate Change: Should I Sell My  

Shore House?” Dept. Earth & Planetary Sciences, Rutgers University and New Jersey Geological 

Survey. 

 

Najjar, R.; Patterson, L.; and S. Graham. (2009). “Climate Simulations of Major Estuarine Wastersheds in  

 the Mid-Atlantic Region of the US.” Climate Change. 95: 139-168 

 

National Oceanic and Atmospheric Administration (NOAA). (2011). Tides and Currents.  

 http://tidesandcurrents.noaa.gov/  

 

………Coastal Services Center (CSC). (2010a). Historical Hurricane Tracks.   

 http://www.csc-s-maps-q.csc.noaa.gov/hurricanes/index.jsp   

 

………Coastal Services Center (CSC). (2010b). Roadmap for Adapting to Coastal Risk.  

 http://www.csc.noaa.gov/digitalcoast/training/roadmap/index.html  

 

 

………Coastal Services Center. (2009). “Stakeholder Engagement Strategies for Participatory Mapping.”  

 http://www.csc.noaa.gov/participatory_mapping/ 

 

………Coastal Services Center. (2009). “Coastal Inundation Mapping Guidebook.”  

 http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf  

 

………Coastal Services Center. (2012). “Coastal Inundation Mapping Guidebook.”  

 http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf  

 

………Coastal Services Center (CSC).  (1999). Community Vulnerability Assessment  

 Tool: New Hanover County, North Carolina. NOAA/CSC/99044-CD. CD-ROM 

http://www.delawareestuary.org/pdf/Climate/IEc-%20Delaware%20Estuary%20SLAMM%20HEA%20-%20June%202010.pdf
http://www.delawareestuary.org/pdf/Climate/IEc-%20Delaware%20Estuary%20SLAMM%20HEA%20-%20June%202010.pdf
http://tidesandcurrents.noaa.gov/
http://www.csc-s-maps-q.csc.noaa.gov/hurricanes/index.jsp
http://www.csc.noaa.gov/digitalcoast/training/roadmap/index.html
http://www.csc.noaa.gov/participatory_mapping/
http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf
http://www.csc.noaa.gov/digitalcoast/inundation/_pdf/guidebook.pdf


 

 

 

63 

 

………Coastal Services Center (CSC).  Inundation Toolkit.  

 http://www.csc.noaa.gov/digitalcoast/inundation/   

………National Hurricane Center. (2011). SLOSH Model. 

http://www.nhc.noaa.gov/HAW2/english/surge/slosh.shtml  

 

………National Geodetic Survey (NDS). (2010). Vertical Transformation Tool  

 (VDatum). http://vdatum.noaa.gov 

 

………National Marine Fisheries Service. (2006). Fisheries Economics of the U.S.  

http://www.st.nmfs.noaa.gov/st5/publication/econ/EconomicsReport_ALL.pdf  

 

New Jersey Department of Environmental Protection (NJDEP). (2007). Valuing New Jersey’s Natural  

Capital: An Assessment of the Economic Value of the State’s Natural Resources. 

http://www.state.nj.us/dep/dsr/naturalcap/   

 

………Office of Coastal Management (NJOCM). (2011a). Coastal Community Vulnerability &  

 Resilience Assessment Pilot: Greenwich Township, Cumberland County, NJ.  

 

............ Office of Coastal Management (NJOCM). (2011b). Getting to Resilience: A Coastal  

 Community Resilience Evaluation Tool.   

 

………Coastal Management Program. (2002). “What is the New Jersey Coast: Fact Sheet 2.”  

 http://www.state.nj.us/dep/cmp/fact2.pdf 

 

New Jersey Sea Grant Consortium. (2010). New Jersey Coastal Community Resilience Demonstration  

Project. http://www.njseagrant.org/pdfs/Extension/New-Jersey-Coastal-Community-Resilience-

Demonstration-Project.pdf  

 

Partnership for the Delaware Estuary (PDE). (2010). Climate Change and the Delaware Estuary: Three  

 Case Studies in Vulnerability Assessment and Adaptation Planning.  

http://www.delawareestuary.org/pdf/Climate/Climate%20Change%20and%20the%20Delaware%

20Estuary%20&%20Appendicies_PDE-10-01.pdf 

 

Program for the Study of Developed Shorelines (PSDS). (2001). Reducing Vulnerability in 5 North  

Carolina Coastal Communities: A Model Approach for Identifying, Mapping and Mitigating 

Coastal Hazards.  Prepared for the NC Division of Emergency Management.  

http://www.wcu.edu/WebFiles/PDFs/psds_Reducing_1991.pdf 

 

Rahmstorf, S. (2007). “A Semi-Empirical Approach to Projecting Future Sea-Level Rise.” Science.  

 January: 368-70 

 

Sempier, T.T., D.L. Swann, R. Emmer, S.H. Sempier, and M. Schneider. (2010). Coastal Community  

 Resilience Index: A Community Self-Assessment. MASGP-08-014.   

http://www.masgc.org/pdf/masgp/08-014.pdf 

 

Subcommittee on Disaster Reduction. (2005). Grand Challenges for Disaster Reduction. National  

Science and Technology Council. Committee on Environment and Natural Resources. Executive 

Office of the President of the United States.  

 

Thieler, E.R and E.S Hammar-Klose. (1999). National Assessment of Coastal Vulnerability to Future Sea  

http://www.csc.noaa.gov/digitalcoast/inundation/
http://www.nhc.noaa.gov/HAW2/english/surge/slosh.shtml
http://vdatum.noaa.gov/
http://www.st.nmfs.noaa.gov/st5/publication/econ/EconomicsReport_ALL.pdf
http://www.state.nj.us/dep/dsr/naturalcap/
http://www.state.nj.us/dep/cmp/fact2.pdf
http://www.njseagrant.org/pdfs/Extension/New-Jersey-Coastal-Community-Resilience-Demonstration-Project.pdf
http://www.njseagrant.org/pdfs/Extension/New-Jersey-Coastal-Community-Resilience-Demonstration-Project.pdf
http://www.wcu.edu/WebFiles/PDFs/psds_Reducing_1991.pdf
http://www.masgc.org/pdf/masgp/08-014.pdf


 

 

 

64 

Level Rise: Preliminary Results for the US Atlantic Coast. U.S. Geological Survey, Open File 

Report 99-593. 

 

U.S. Census Bureau. (2010). Census 2010. http://2010.census.gov/2010census/    

 

U.S. Indian Ocean Tsunami Warning System Program. (2007). How Resilient is Your Coastal  

Community? A Guide for Evaluating Coastal Community Resilience to Tsunamis and Other 

Coastal Hazards. US IOTWSP supported by the United States Agency for International 

Development and partners, Bangkok, Thailand.  

 

Worldwatch Institute. (2009). State of the World: Into a Warming World.  Chapter 5: Building  

 Resilience.  http://www.worldwatch.org/files/pdf/SOW09_chap5.pdf  

 

 

 

 

 

http://2010.census.gov/2010census/
http://www.worldwatch.org/files/pdf/SOW09_chap5.pdf

